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Bienvenido a tu curso 
 
 
Revit Mep fundamentos 
  
Al terminar este curso estarás preparado para modelar sistemas mecánicos e hidráulicos y 
circuitos eléctricos con sus conexiones, equipos, segmentos de tuberías, ductos o tubos, 
trazando manualmente las ramificaciones o utilizando las opciones de ruteo sugeridas por 
el software.  
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Capítulo 1 
 
 

Concepto de BIM (Building Information Modeling) 
 
BIM es una metodología para el manejo integral y compartido de un inmueble durante todo 
el ciclo de vida, desde el diseño conceptual, el proyecto ejecutivo y la construcción, hasta 
la operación, la administración y su mantenimiento. 
Esta metodología permite tener una mejor visibilidad y certeza de que un proyecto de 
construcción o remodelación se va a coincidir en el tiempo, forma y preció calculado 
originalmente. 
Tradicionalmente los modelos de construcción han sido creados utilizando sistemas CAD. 
La información relacionada con la documentación de los proyectos ha sido agregada 
creando planos adicionales, notas y otros documentos con especificaciones.  Con los 
avances de la tecnología CAD, algunos de estos procesos han sido automatizados, sin 
embargo, la documentación del proyecto aún no se maneja de acuerdo con los parámetros 
que debe tener un proyecto de construcción. 
 
Nota: Hay organizaciones que realizan eventos para hablar sobre esta metodología y su 
innovación día a día, algunas organizaciones son nacionales y otras más son extranjeras, 
España, por ejemplo, cuenta con un gran avance en base a BIM, cuenta con instituciones 
enfocadas en el desarrollo a este tema. 
 

Asociatividad Bidireccional  
 
Una de las herramientas clave de Revit Mep es que los cambios en el proyecto son 
bidireccionales, esto asegura que los cambios realizados en cualquier parte del diseño son 
inmediatamente reflejados en todas las partes asociadas. 
Asociatividad bidireccional es entonces la habilidad de Revit para coordinar los cambios 
hechos en cualquier vista, con la base de datos y las demás vistas. Por ejemplo, el cambio 
de la dimensión una tubería, ducto, Conduit etc., que están en el proyecto se ven reflejados 
en los listados de cuantificación. 
 

 
 
  



Parametría 
 
El término paramétrico se refiere a las relaciones entre todos los elementos del modelo que 
permiten la coordinación y gestión de cambios que Revit Mep ofrece. Estas relaciones se 
crean en forma automática a través del software o por usted mientras trabaja. 
 
En matemáticas y CAD mecánico, los números o las características que definen este tipo 
de relaciones se llaman parámetros, por lo que la operación del software es paramétrica. 
Esta capacidad ofrece una coordinación fundamental y beneficios de productividad en Revit 
MEP: puede realizar una modificación al proyecto en cualquier momento y Revit MEP 
coordinará los cambios a través del proyecto completo. 
Revit Mep determina de una forma inmediata los elementos que se ven afectados, esta es 
una herramienta fundamental para coordinar los cambios y mantener la coherencia en el 
modelo. 
 

 

Formatos de archivo en Revit 
 
Puede crear archivos de diferentes formatos según el tipo de documentos que requiera 
generar: 
 

• RVT: Formato para proyectos. 

• RFA: Formato para familias cargables. 

• RTE: Formato para plantillas de proyectos. 

• RFT: Formato para plantillas de familias.  
 

 

Plantillas de proyecto (RTE) 
 
Utilice plantillas de proyecto como punto de partida para los nuevos modelos. Utilice las 
plantillas por defecto o defina plantillas personalizadas para que se cumplan las normas de 
la empresa. Una plantilla de proyecto puede incluir plantillas de vista, familias cargadas, 
parámetros definidos (como unidades, patrones de relleno, estilos de línea, grosores de 
línea, escalas de vista, etc.) y geometría, si se desea.  
 
Las plantillas de proyecto usan la extensión de archivo RTE.  
 

Archivos de proyecto (RVT) 
 



En Revit un proyecto es el diseño entero del edificio y la documentación asociada a este.  
Todas las vistas estándares del edificio, y las tablas de cuantificación se incluyen en el 
proyecto.  Siempre que se cambie el modelo, todas las visitas relacionadas, los dibujos, y 
las tablas se ponen al día automáticamente.   
 
Para iniciar un proyecto no se requiere un procedimiento rígido ni estandarizado, este puede 
iniciarse de diversas formas dependiendo las necesidades y complejidad, pero si se 
requiere tener una estrategia definida, antes de empezar a incluir cualquier componente en 
el proyecto, así que antes de iniciar un proyecto se tienen que tener en cuente algunas de 
las siguientes sugerencias: 
 

• Configurar unidades de medida 

• Definir el número de niveles con los que cuenta el edificio 

• Iniciar el trazo preferentemente con los muros exteriores 

• Ligar el comportamiento de los muros con los niveles 
 
Cuando se comienza un nuevo proyecto se crea dos niveles de información por defecto, 
además se realizan automáticamente varias funciones.  Primero, se carga un archivo 
plantilla que contiene un subconjunto de componentes y de ajustes del sistema.  Esto pone 
los componentes a disposición para que el usuario comience a crear su diseño.  Los 
componentes individuales se van creando por el usuario más adelante, según los vaya 
necesitando.   
 
Para crear un proyecto: 

1. Escoger pestaña File => opción  =>  
 

 
 

2. En la caja de dialogo New Project desplegar la casilla Template file, para seleccionar 
el archivo de plantilla. 

 

 
 

3. En la sección Create new, escoger opción Project 



4. Presionar el botón OK. 
 

Archivos de familia (RFA) 
 
las cargables se crean en archivos RFA externos y se importan (se cargan) a los proyectos. 
 
Para cargar una familia al Proyecto: 

1. Escoger pestaña Insert => Panel Load from library => icono   (Load Family) 
2. Seleccionar una librería, y luego abrir la carpeta correspondiente a la categoría de 

familia. 
3. Seleccionar el archivo RFA que se requiere cargar al Proyecto. 

 

 
 
 

Tipos de familia 
 
Una familia está compuesta por un conjunto de características, parámetros y un modelo 
geométrico, todos interrelacionados. Estas características pueden ser distintas en otros 
elementos de la misma familia, a estos elementos se les conoce como Tipos. Los tipos 
incluyen los mismos parámetros, pero con diferente información.  
 
Ejemplo: Una familia de luminaria puede tener varios tipos, cada tipo puede tener diferente 
costo, descripción, modelo, etc.  
 
Los tres tipos de familia son: 
 

Familias de sistema 
 
Son parte del entorno de Revit, utilizadas para crear elementos básicos de los sistemas. 
Las familias de sistema están predefinidas en Revit. Ejemplo: Tuberías, Ductos, Tubos 
Conduit, Charolas. 
 



 
Familias cargables 
 
Estas se utilizan para crear componentes proyecto, de las ingenierías, elementos de 
documentación. Cuentan con la característica que pueden ser distintas entre ellas. De estas 
se pueden generar catálogos de familias, librerías. Ejemplo: Unidad de paquete, Ventilador 
extracción, Luminaria, Retrete.  
 

 
Estas familias tienen las siguientes características: 

  
• familias creadas independientemente del modelo y cargadas en el modelo según es 

necesario.  

• familias utilizadas para crear componentes de ingenierías como equipos, luminarias, 
etc. 

• familias que, a menudo, tienen como anfitrión familias de sistema. Por ejemplo, 
ductos, tuberías, charolas, muros, pisos, plafones. 

 
Al ser tan personalizables, las familias cargables son las que se crean y modifican con 
mayor frecuencia en Revit. A diferencia de las familias de sistema, las cargables se crean 
en archivos RFA externos y se importan a los proyectos o se cargan en ellos. Para las 
familias cargables que contienen muchos tipos, puede crear y utilizar catálogos de tipos a 
fin de cargar únicamente los tipos que se necesitan para un proyecto. 
 

Familias de sitio 
 
Las familias en sitio son aquellas que necesita crear el usuario para un proyecto exclusivo, 
la creación de familia es igual que las familias cargables, solo que esta queda anidada en 
el proyecto.  
 



 
 

Interfaz de usuario 
 
El interfaz de Revit está elaborado para simplificar el flujo del trabajo del usuario. Cuenta 
con iconos de fácil acceso y forma de identificar. 
 
A continuación, se muestran las partes principales: 
 

1. Menú File: El menú Archivo permite acceder a las acciones base como crear un 
nuevo proyecto, abrir, salvar, imprimir y publicar.  
 

Para ver las opciones existentes del menú File: 
 

a. Hacer clic sobre la pestaña File 
b. Seleccionar la opción deseada en la lista.  

 
 
 



 
(1) Cuadro de dialogo nuevo proyecto 
(2) Cuadro de dialogo abrir 
(3) Cuadro de dialogo de publicación  
(4) Cuadro de dialogo imprimir 

 
2. Quick Access Toolbar: La barra de herramientas de acceso rápido contiene una 

serie de herramientas para su fácil acceso. Estas herramientas se pueden 
personalizar para colocar las más usadas o con mayor frecuencia. 

 
 
 

 
 

3. InfoCenter: Es una barra que proporciona un conjunto de herramientas que 
permiten acceder a fuentes de información con referencia al software.  

InfoCenter usa como base “Internet Explorer” pero se puede configurar otro navegador en 
específico.  
Las opciones principales de infocenter son: 



 

• El botón Buscar  permite buscar rápidamente la información deseada.  
 

• Presionar tecla F1 para acceder a la ayuda y soporte de Autodesk. 
 

• Iniciar sesión (sign In): Permite acceder a todos los servicios disponibles 
mediante la cuenta vía suscripción. 

 

 
 

4. Options Bar: La barra de opciones se localiza debajo de la cinta Ribbon, las 
opciones que se muestran dependen del comando u objeto seleccionado. 

 

 
 
 

5. Properties Palette: La paleta de propiedades permite modificar los parámetros que 
definen las características y propiedades de los objetos. Hay dos tipos de 
propiedades, “Propiedades de tipo” y “Propiedades de ejemplar (instancia)”. 
Normalmente la paleta de propiedades se mantiene activa durante la sesión. 
Cuando no se encuentra seleccionado ningún objeto, la paleta mostrara las 
propiedades de instancia de la vista activa. 

 



 
 

6. Project Browser: El navegador de proyectos se muestra una jerarquía de la 
información mediante vistas, vistas de detalle, planos, listados de cuantificación, 
grupos, familias. Este cuadro permite expandir o contraer los elementos. 

 
Dependiendo del tamaño del proyecto, pueden contener varias entradas, esto con 
la finalidad de tener una mejor organización.  
Puede personalizar la organización de las vistas, planos, listados de tabla para 
adecuarse al proyecto que se esté trabajando.  

 

 
 

7. Status Bar: La barra de estado muestra información relevante con respecto a la 
sesión, incluye consejos o sugerencias, esta barra se encuentra en la parte inferior 
de la ventana de la aplicación.  

 
En esta barra se muestras otros controles: 
 

• Worksets: Es el acceso rápido a los worksets cuando el proyecto es 
compartido 

• Opciones de diseño (Design Options): Es el acceso rápido a las opciones de 
diseño generadas. 



 

 
 
 

8. View Control Bar: La barra de controles de vista permite acceder de forma rápida 
a las funciones graficas de la vista activa. Esta barra se encuentra en la parte inferior 
de la vista.  

 

 
 
Las funciones de la barra de herramientas View control Bar son: 
 

• Scale: La escala de la vista es proporcional cuando se desea representar un 
modelo, las escalas son por vista.  

 
Hay dos modos de cambiar la escala en una vista, la primera en la paleta de propiedades, 
la segunda en la barra de controles de vista.  
 
Cambio de escala por paleta de propiedades: 
 

a. En la paleta de propiedades, en las propiedades de instancia, buscar 
casilla View Scale 

b. Desplegar la casilla View Scale, y seleccionar la escala deseada para la 
vista. 

 
 



 
Cambio de escala por barra de controles de vista: 
 

a. Ubicar el icono que indica la escala actual de la vista. 
b. Hacer clic para desplegar las opciones de escala. 
c. Escoger la escala requerida. 

 

 
 

• Detail Levels: Permite definir el nivel de detalle de la geometría en la vista 
creada, los tres niveles con los que se cuenta en esta herramienta son: 

 
▪ Low: Muestra la forma base de los objetos  
▪ Medium: Muestra algunos detalles de los objetos 
▪ Fine: Muestra todo el nivel de detalle de los objetos  

 
Para cambiar el nivel de detalle de una vista desde el View control Bar: 
 

a. Desde la barra de controles de vista hacer clic sobre el icono Detail 
level 

b. Seleccionar el nivel de detalle requerido 
 



 
 
Cambio de nivel de detalle desde la paleta de propiedades: 
 

a. En la paleta de propiedades, bajo el grupo de parámetros 
Graphics escoger opción Detail Level. 

b. Escoger el nivel de detalle requerido. 
 

 
Ejemplos de niveles de detalle: 
 

 
 

• Visual Styles: Pues especificar los diferentes estilos gráficos en una vista. Los 
estilos visuales existentes son: 

 
▪ Wireframe: Muestra el modelo con una estructura alámbrica, muestra el 

modelo con todos los bordes, pero sin superficies sólidas. 
 

▪ Hidden line: Muestra el modelo con líneas, en esta vista se puede configurar 
el valor de transparencia por categoría.  

 
▪ Shaded: Muestra el modelo en modo sombreado y permite ver la luz directa 

y sombras de este.  
 



▪ Consistent Colors: Muestra el modelo con colores consistentes y sin 
sombras. 

 
▪ Realistic: Muestra el modelo con la apariencia de sus materiales. 

 
▪ Ray trace: Muestra el modelo en modo de renderización en tiempo real.  

 
Para cambiar un estilo visual: 
 

a. Activar la vista correspondiente.  
b. En la barra de controles de vista seleccionar icono estilos visuales. 
c. Seleccionar entre las opciones de la lista el estilo deseado.  

 

 
Ejemplos de estilo visual: 

 
 

• Temporaly hide or isolate elements or element Categories: Permite ocular, 
aislar los elementos por objeto o por categoría.  



 
▪ La herramienta ocultar esconde los elementos seleccionados en la 

vista 
▪ La herramienta aislar, muestra solo los elementos seleccionados en 

la vista  
 
Para ocultar objetos con herramienta ocultar: 
 

a. Seleccionar los objetos que desea ocultar.  
b. Hacer clic en icono Temporary Hide/Isolate. 
c. Escoger la opción Hide element para ocultar los elementos o 

seleccionar Hide Category para ocultar la categoría.  
 

 
 
Para aislar elementos Herramienta aislar:  
 

a. Seleccionar los objetos a aislar. 
b. Hacer clic en icono Temporari Hide/Isolate. 
c. Escoger la opción Isolate Element para ocultar los objetos que no 

están seleccionados o seleccione Isolate Category para aislar por 
categoría.  

 

 
 

• Reveal and unhide hidden elements: Permite ver de forma temporal los 
elementos ocultos, o permite visualizarlos de forma permanente.  

 
Para activar la visualización de elementos: 
 



a. Seleccionar el botón Reveal hidden elements para activar el recuadro de 
visualización. Los objetos que NO están visibles se muestran de color rojo. 

 

 
 

b. Seleccionar los objetos que serán visibles. 

c. Presionar botón  Unhide element, unhide Category.  

d. Para finalizar el comando presionar el botón  Toggle Reveal Hidden 
elements mode.  

 
1. Drawing Area: El área de dibujo muestra las vistas del proyecto que se 

encuentren activas, cada vista abierta se almacena en forma de pestaña. 
 
Para ordenar las vistas en el área de dibujo: 

a. En la pestaña View => panel Windows => escoger botón   (Tile Views) o 
presionar las teclas WT en el teclado. 

 

 
 
Para cerrar las vistas inactivas: 
 
a. Activar la vista que se requiere mantener abierta. 



b. En la pestaña View => panel Windows => escoger botón  Close inactive   
o ir a la barra de herramientas de acceso rápido. 

 

 Menú de cinta (Ribbon) 
 
La cinta de opciones se activa al crear un nuevo proyecto o familia, dentro de esta cinta 
encontrara las herramientas necesarias para desarrollar un proyecto. Dependiendo del 
tamaño de la ventana o monitor, puede cambiar el tamaño de esta cinta. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Grupos expandidos  
 
los grupos expandidos son aquellos paneles que permiten expandir el grupo de 
herramientas, para esto, aparecerá una flecha junto al título del panel, al hacer clic a ese 
elemento le mostrará las herramientas u opciones adicionales.  
 
 
 
 
 

 

 

 

 

 

 

 
  



Apertura de cuadro de dialogo  
 
Algunos paneles permiten abrir un cuadro de dialogo para cambiar las propiedades 
o parámetros relacionados con el mismo. La flecha se sitúa a un costado del panel, 
al hacer clic abrirá el cuadro de dialogo.  

 
 
 
 
 
 
 
 
 
 
 
 
 

Navegador de proyectos 
 
El navegador de proyectos muestra jerarquía de las vistas, tablas de cuantificación, planos, 
grupos y otras propiedades elementales del proyecto.  
 
Para abrir el navegador de proyectos siga estos pasos: 
 

1. Seleccione la pestaña View => Herramienta User Interface => Botón Project 
Browser. 

 

 
Búsqueda en el navegador 
 
Cuando los proyectos son complejos o completos, las vistas pueden ser difíciles de localizar 
en el listado del navegador de proyectos. Para esto hay tres modos de exploración y 
búsqueda: 
 

1. De clic derecho sobre el Navegador de proyectos => Seleccionar la opción 
Search… 
 

a. En el cuadro de dialogo ingresar el nombre de la vista a localizar. 



b. Dar click en el botón Next para que se vaya mostrando las vistas que 
coinciden.  

 

 
 

2. Dar clic derecho sobre el Navegador de proyectos => Seleccionar la opción Expand 
all para expandir todo el navegador, incluyendo, vistas de planos, vistas de leyenda, 
vistas de detalle, grupos, familias.  

 

 
3. Dar clic derecho sobre el Navegador de proyectos => Seleccionar la opción Collapse 

all para minimizar las secciones jerárquicas de las vistas, incluyendo, vistas de 
planos, vistas de leyenda, vistas de detalle, grupos, familias. 
 
 

 
 

Vistas de modelo 
 
Revit cuenta con diferentes tipos de vista, vistas que son para administración del proyecto, 
vistas que son para entrega de proyecto, vistas de presentación, vistas para 
documentación, vistas de análisis y diseño, etc., sin embargo, la mayor parte de las vistas 



en las que se desarrolla la información, son las vistas de modelo, estas son las vistas donde 
uno desarrolla las ingenierías  
 
A continuación, se muestran cuáles son las vistas de modelo 
 

 
 

• Floor Plans: Vista de planta bidimensional del proyecto desarrollado. 

• Ceiling Plans: Vista de plafón bidimensional del proyecto desarrollado, enfocado 
para el desarrollo de ingenierías colocadas en plafón o arriba de este. 

• 3D Views: Vistas del modelo tridimensional del proyecto desarrollado, enfocado 
para corroborar la geometría modelada. 

• Elevations: Vistas de alzado bidimensional del proyecto desarrollado. 

• Sections: Vistas de corte bidimensional del proyecto desarrollado. 

• Area plans: Vistas de área de planta bidimensional del proyecto desarrollado 
 
De estas vistas existentes hay derivados de acuerdo con las características y necesidades 
del proyecto. En Mep las vistas están enfocadas para desarrollar vistas de las ingenierías 
y dar como prioridad su visualización. Algunas de estas vistas son: 
 

• Hvac Plans 

• Plumbin Plans 

• Electric Plans 
 
Cada una de estas vistas cuenta con características visuales específicas para mejorar la 
visibilidad de la ingeniería. Dentro de las herramientas vistas en este módulo se pueden 
preparar vistas para cada caso.  
 

Herramientas de navegación y edición  
 

Herramienta de Zoom 
 
Para poder hacer zoom en las vistas siga estos pasos: 
 

1. Identifique la vista en donde desea navegar 
2. Con el ratón o mouse identifique la rueda de giro, gire hacia adelante para aumentar 

la vista, gire hacia atrás para alejar la vista 



 
Herramienta de Paneo 
 
Para hacer un paneo en las vistas siga estos pasos: 
 

1. Identifique la vista en donde desea navegar 
2. Con el ratón o mouse identifique la rueda de giro, presione y mueva el mismo para 

cambiar el área de visualización 

 
Herramienta de giro en vistas 3D 
 
Para hacer giro en las vistas siga estos pasos: 
 

1. Identifique la vista 3D 
2. Presione la tecla Shift + Rueda de ratón o mouse + movimiento del mismo 

 

 
Selección de objetos 
 
Para seleccionar objetos de forma individual en Revit: 



 
1. Hacer clic sobre el objeto hasta que se coloque de color azul 

 

 
 

2. Para quitar la selección presionar la Tecla Esc del teclado 
 
Para seleccionar varios objetos usando el cursor: 
 

1. Seleccionar el primer objeto. 
2. Presionar la Tecla Ctrl del Teclado y mantenerla presionada mientras se realiza la 

sección de los objetos adicionales haciendo clic sobre estos. 
 
Para eliminar objetos de un conjunto de objetos que están seleccionados. 
 

1. Debe haber varios objetos seleccionados. 
2. Presionar la Tecla Shift del Teclado y mantenerla presionada mientras se realiza la 

sección de los objetos que desea sacar de la selección. 
 
Para seleccionar objetos a través de una Ventana de selección: 
 

1. Hacer click cerca de los objetos a seleccionar. 
2. Mantener presionado el botón izquierdo del mouse 
3. Desplazar el cursor formando una Ventana de selección. 

 

 
 
 
Para seleccionar elementos que pertenecen a un sistema y que están conectados: 
 

1. Ubicar el puntero sobre el primer objeto del sistema y observar que se resalta de 
color azul. 



 

 
 

2. Presionar la tecla TAB en el teclado, las veces que sea necesario hasta que se 
resalten los objetos del sistema que están conectados 

 

 
3. Hacer clic sobre uno de los objetos, para que se realice la selección. 

 

 
   
 

Filtros de selección 
 
Si en una selección hay elementos de diversas categorías, puede aplicar un filtro para 
eliminar de la selección las categorías que no desee. Por ejemplo, si en una selección hay 
muros, puertas, ventanas y mobiliario, puede utilizar un filtro para omitir el mobiliario.  
 
Para aplicar un filtro de selección: 
 

1. Seleccionar los objetos a través de una ventana de selección. 
 



 

2. Escoger la pestaña contextual Modify Multi-select => panel Selection => icono  
(Filter) 

3. En el cuadro de dialogo Filter se despliega el listado de las categorías a la que 
pertenecen los elementos que están seleccionados en la vista. 

4. Dejar activa solo las categorías que se requiere mantener seleccionadas. Por 
ejemplo, la imagen muestra que la única categoría que se quiere dejar seleccionada 
es terminal de aire. 

 

 
 

5. Presionar el botón Ok. Como resultado se observa que solo los objetos de las 
categorías que quedaron activas permanecen seleccionados. 

 
 

 
 



Comando de edición 
 
Revit cuenta con las herramientas necesarias para poder editar la geometría, estas 
herramientas se habilitan una vez que se accede a la pestaña Modify o se selecciona un 
objeto. 
 
La mayoría de los comandos de edición se pueden activar seleccionando el objeto y luego 
escoger pestaña Modify => Panel Modify. 
 

 
 

Align  
 
Mediante la herramienta Alinear, alinee uno o más elementos con un elemento 
seleccionado. Es una herramienta que suele usarse para alinear ductos, tuberías, 
luminarias etc.  
 
Pasos alinear objetos: 
 

1. Seleccione el icono  (Align) 
2. Hacer clic sobre el elemento con el que quiere alinear. 

 

 
 

3. Seleccione la línea de referencia del objeto a alinear. 
 



 
 
 

Move 
 
La herramienta Mover funciona de forma parecida a la acción de arrastrar. Sin embargo, 
presenta funciones adicionales en la barra de opciones y permite una colocación más 
precisa. 
 
 
Pasos desplazar objetos: 
 

1. Seleccione el objeto a mover 
 

 

2. Seleccione la herramienta  Move 
3. Seleccione el punto de desplazamiento. 

 



 
 

4. Haga clic sobre el punto final de posicionamiento. 
 

 
 
Nota: Puede ingresar un valor numérico en la cota temporal para establecer la distancia de 
desplazamiento del objeto.  
 

Offset 
 
Use la función Desfase para crear, copiar o mover un elemento seleccionado, como un 
muro o una viga, a una distancia especificada y en dirección paralela al elemento 
seleccionado. 
 
Para desfasar un elemento: 
 

1. Seleccione la herramienta  (offset)  
2. En la barra de herramientas de opciones, establezca la distancia de desfase, activar 

la casilla Copy, en caso de realizar una copia del objeto.  
 

 
3. Seleccionar el objeto a desfasar. 

 



 
 

4. Una línea punteada paralela al objeto se proyecta a la distancia especificada. 
 

 
 

5. Hacer clic para crear el nuevo elemento. 
 

6. Para concluir el comando, dar clic en el botón Modify o presionar tecla Esc. 
 

 
Copy 
 
La herramienta Copiar permite copiar uno o varios elementos seleccionados, y se usa para 
colocar las copias en el dibujo de manera inmediata y a una distancia específica. 
 
Para copiar objetos: 
 

1. Seleccione el objeto  



2. Seleccione la herramienta  Copy 
3. En la barra de herramientas de opciones, seleccione el modo de copiado 

 

 
 
Multiple: Para realizar varias copias del elemento seleccionado 
Constrain: Restringe el movimiento del cursor en modo ortogonal. 
 

4. Seleccione el punto base de desplazamiento. 
 

 
 
 

5. Haga clic sobre el punto donde se creará la copia, o ingrese el valor de distancia en 
la cota temporal. 

 

 
 

Mirror pick axis 
 
La herramienta Mirror invierte la posición de un elemento de modelo seleccionado, 
utilizando para ello una línea como eje de simetría. Puede designar el eje de reflejo o dibujar 
un eje temporal. Use la herramienta Reflejar para voltear un elemento seleccionado, o para 
copiar un elemento e invertir su posición en un paso.  
 
Para reflejar un objeto: 
 

1. Seleccione el objeto que desea espejear 
 



 

2. Seleccione la herramienta  Mirror pick axis. 
3. Seleccione el elemento que servirá como eje para realizar el espejeado  

 
4. Termine el comando, de clic en el botón Modify o presionar tecla Esc. 

 
 
 

Mirror Draw axis 
 
Se debe dibujar el eje de ferencia para generar el espejo, definiendo un punto inicial y un 
punto final. 



 
Para reflejar un objeto dibujando el eje: 
 

1. Seleccione los objetos a espejear  
 

 

2. Seleccione la herramienta  Mirror Draw axis  
3. Dibuje la línea que representa el eje par el espejo.  

 
 

 
 

4. Finalice el comando con el botón Modify o presionar la tecla Esc. 

 
Rótate 
 



Rotar permite que los elementos roten en torno a un eje.  En las vistas de plano de planta, 
de techo, alzado y sección, los elementos rotan en torno a un eje perpendicular a la vista. 
En las vistas 3D, el eje es perpendicular al plano de trabajo de la vista. 
 
Para rotar un objeto: 
 

1. Seleccione el objeto. 

2. Seleccione la herramienta Rotate, 
3. En la barra de opciones activar Copy, en caso de requerir generar una copia. 
4. Hacer clic sobre la opción Place para determinar el punto de rotación.  

 

 
  
Una vez identificado el punto a usar cómo eje de rotación, hacer clic sobre este para dejarlo 
fijo. 
 

 
 

5. Desplace el puntero para determinar el inicio del ángulo de rotación, se mostrará 
una línea interactiva.  
 

 
 

6. Definir el ángulo final de rotación, desplazando el puntero en el ángulo requerido o 
ingresando el valor del ángulo en la cota temporal. 

 



 
7. Finalice el comando, de clic en el botón Modify o presionar tecla Esc. 

 

 
 

Trim / Extend 
 
Utilice las herramientas Recortar y Extender para recortar o extender uno o varios 
elementos en un contorno. También puede extender elementos no paralelos desde una 
esquina, o recortarlos desde una esquina si intersecan. Cuando selecciona un elemento 
para recortarlo, la posición del cursor indica la parte del elemento que desea conservar. 
Puede utilizar esta herramienta para elementos como ductos, tuberías o charolas. 
 
Revit cuenta con tres opciones para recortar / extender elementos: 
 

Trim/Extend to Corner  
Se usa cuando un elemento debe recortarse para conformar una esquina.  

Trim/Extend Single element  
Se usa para recortar o extender un elemento hasta un contorno definido por otro elemento. 
 



Trim/Extend Multiple Elements  
Se usa para recortar o extender elementos hasta un contorno definido por otro elemento. 
 
 
Para extender objetos: 
 

1. Identifique los objetos a extender 

2. Seleccione la herramienta icono    o o  (Trim/Extend)  
3. Seleccione el objeto con el que quiere conectar. 

 
4. Seleccionar el objeto a extender. 

 
5. Finalice el comando, de clic en el botón Modify o presionar tecla Esc. 

 
 
Para recortar elementos: 
 



1. Escoger pestaña Modify => Panel Modify => icono    o o  (Trim/Extend) 
2. Seleccionar el objeto que servirá de límite o contorno.  

 

 
 

3. Seleccione el objeto a recortar. Debe seleccionarlo del lado que desea conservar. 
 

 
4. Según la herramienta seleccionada el resultado se observa en las siguientes 

imágenes. 
 

    
 
Trim/Extend to corner   Trim/Extend Element(s) 
 

 

Split Elements 
 
Corta los elementos en un punto seleccionado. 
 
Para cortar elementos: 
 

1. Seleccione la herramienta  Split elements 
2. Identifique el objeto que desea cortar 
3. Hacer click sobre el objeto en el punto donde quiera cortar  

 



 
 

4. Finalice el comando, de clic al botón Modify o presione la tecla Esc. 
 

 
 

Array 
 
Genera un arreglo radial o lineal de elementos seleccionados, creando varios ejemplares a 
partir de uno o más elementos que se agrupan y pueden ser modificados simultáneamente.  
Los elementos de la matriz pueden pertenecer a un grupo. Por lo tanto, puede agregar o 
quitar elementos del grupo. Hay dos tipos de matrices lineales y radiales. 
 
Para crear un array lineal: 
 

1. Seleccione el objeto  
 

 
 

2. Seleccione la pestaña Modify => Panel Modify => Comando Array  

3. En la barra de opciones seleccione el tipo de matriz lineal  
4. En la barra de herramientas de opciones en la casilla Number, ingresar el número 

de elementos que tendrá la matriz. 
 



 
 

5. En la barra de herramientas de opciones, escoger la opción para contar la cantidad 
de objetos según el valor colocado en la casilla Number.  

 
• 2nd: cuenta los elementos a partir del segundo elemento (Por ejemplo; si en la 

casilla Number se ingresó el valor 10, se crean 10 elementos nuevos).  

• Last: cuenta los elementos incluyendo el del primer objeto colocado por el 
usuario (Por ejemplo; si en la casilla Number se ingresó el valor 10, se crean 9 
elementos nuevos). 

 
6. Seleccionar el punto base sobre el objeto para crear los nuevos objetos. 

 
 

7. Desplazar el puntero para determinar la distancia entre los elementos de la matriz 

 
8. Presionar el comando Enter para terminar el comando. 

 
Para cambiar la cantidad de elementos en la matriz: 



 
1. Seleccionar cualquiera de los elementos que forma parte de la matriz 
2. Hacer clic sobre la cota temporal que muestra el número de elementos de la matriz. 
3. Cambie el número de objetos. 

 

 
 

4. Presionar Enter. 
 
Para crear una matriz radial: 
 

1. Seleccione el objeto  

 

2. Seleccione la pestaña Modify => Panel Modify => Comando Array  

3. En la barra de opciones seleccione el tipo de matriz radial  
4. En la barra de herramientas de opciones en la casilla Number, ingresar el número 

de elementos que tendrá la matriz. 
 

 
 

5. Modificar el centro de rotación. En la barra de opciones hacer clic sobre el botón 

 e indicar el nuevo centro de rotación, desplazándolo a la 
ubicación requerida. 

 



 
6. Establezca valor del ángulo que cubre la matriz completa. En la barra de 

herramientas de opciones ingresar el valor del ángulo  . 
 

7. Presionar Enter. 
 

8. Puede cambiar el número de elementos, ingresando un número de elementos en la 
cota temporal que queda activa. 
 

 
 

9. Finalice el comando, de clic al botón Modify. 
 
 

Pin / Unpin 
 
Bloquea o desbloquea la ubicación de un objeto. 
 
Para bloquear la ubicación de un objeto: 
 

1. Seleccione el o los objetos que desea bloquear. 

2. Seleccione la herramienta   Pin. 
3. Observar el símbolo de Pin sobre los objetos.  

 



 
 

4. Finalice el comando, de clic al botón Modify o presionar botón Esc. 
 
Para desbloquear la ubicación de un objeto: 
 

1. Seleccione los objetos bloqueados. 

2. Seleccione la herramienta  unpin. 
3. Finalice el comando, de clic al botón Modify o presionar botón Esc. 

 

 
 

Delete 
 
Permite borrar elementos del proyecto. 
 
Para borrar objetos: 
 

1. Seleccione los objetos que desea eliminar 
 



  

2. Seleccione la herramienta  Delete 
3. Finalice el comando, de clic al botón Modify o presionar tecla Esc. 

 

 
 
 

Scale 
 
Cambia el tamaño de los elementos modelo. Revit calcula un factor de escala utilizando 
dos opciones, gráfica o numérica. 
 

• La escala gráfica: cambia la escala de elementos gráficamente, definiendo tres 
puntos: el primer punto determina el origen; los otros dos definen los vectores de 
escala. 



• La escala numérica: se cambia indicando un factor de escala y especificando el 
origen. 

 
Para cambiar la escala de un elemento: 
 

1. Seleccionar un objeto. 

2. Escoger la pestaña Modify => Panel Modify => comando Scale  
3. Hacer clic sobre el punto base escogido para cambiar el tamaño del objeto. 
4. Definir el segundo punto o punto de arrastre (B) 
5. Definir tercer punto para determinar el nuevo tamaño (C) 

 
 

6. Finalice el comando, de clic el botón Modify 
 

 
 

Match Type Properties 
 
Convierte uno o varios elementos a fin de igualar el tipo asignado a otro elemento. Los 
elementos de origen y de destino deben pertenecer a la misma categoría general.  
 
 
Para igualar propiedades en elementos: 
 

1. seleccionar la herramienta  Match Type Properties. 
2. Seleccione el objeto del cual se copiarán sus propiedades. 

 



 
3. Seleccione los objetos que adquirirán las propiedades 

 

 
4. Finalice el comando, de clic al botón Modify o presionar la tecla Esc. 

 

Copy to clipboard 
 
La herramienta Copiar a portapapeles copia uno o más elementos en el portapapeles. A 
continuación, para pegar copias de los elementos en el dibujo activo o en otro proyecto 
debe utilizar las herramientas Pegar desde portapapeles o Pegar alineado. 
 
Para copiar y pegar objetos del portapapeles: 
 

1. Seleccione los objetos 

2. Seleccione la herramienta de  Copy to clipboard 

3. Escoger pestaña Modify => panel Modify => icono   (Paste) 
Se despliegas las opciones disponibles para pegar objetos que están en el 
portapapeles. 



 

 
 
Por ejemplo un uso comun de esta herramienta es copiar objetos a otros niveles del 
proyecto, entonces: 

1. Esccoger la opción  
2. Se puede seleccionar uno o más niveles en el listado de la caja de dialogo select 

Levels 
 

 
 

3. Presionar el botón OK. 
 
Nota: Esta herramienta también se usa para copiar la geometría de las opciones de diseño 
y pegarla en la opción del modelo principal.  
 

Uso de Snaps 
 
Cuando se crea o se coloca un elemento, sobre puntos específicos se muestra los Snaps, 
que ayudan a tomar un punto exacto sobre la geometría existente. 
 
Existen tres tipos de Snaps: 
 

• Longitud: Realiza el ajuste del valor de longitud de los objetos 

• Angulo: Activa una serie de valores (grados) en base a un incremento 

• Objeto: Son todos los Snaps de dibujo para alinear o trazar los objetos.  
 



Ejemplo de snap de longitud: 
 

 
Ejemplo de snap de Angulo. 

 
Activar/Desactivar Snaps 

1. Seleccionar la pestaña Manage => Panel Settings =>  (Snaps) 
2. Activar o desactivar la casilla Snaps Off  

 
 

Cotas temporales 
 
Cuando se crea o se selecciona un objeto en el área de dibujo, Revit añade las cotas 
temporales con respecto a otros objetos. Haga uso de las cotas para controlar el 
posicionamiento o cambio dinámico del objeto. 
 
Para ver las cotas temporales los objetos deben estar seleccionados, al des seleccionar los 
objetos las cotas temporales no son visibles. 
  



Las cotas cuentan con una línea de referencia la cual está asociada a un objeto, para 
cambiar la referencia, se debe mover la línea sobre otro punto.  
 

Activar cotas temporales sobre varios objetos 
 
Para activar las cotas temporales sobre varios objetos, siga estos pasos: 
 

1. Seleccionar varios objetos. 
2. En la barra se opciones hacer clic sobre el botón Activate Dimensions  

 

 
 

3. Modificar las cotas temporales. 
 

 
 

Cambio de referencia de cota temporal 
 

1. Seleccionar el punto de referencia de la cota 

 
2. Colocar la referencia sobre el objeto y punto deseado 



 
3. Cambiar el valor de la cota temporal 

 

 
 
 

Convertir cota temporal a cota permanente 
 

1. Seleccionar la cota temporal que desea convertir en permanente. 
2. Hacer clic sobre la marca Make this temporary dimensión permanent.  

 



 

Configuración de cotas temporales 
 
Las cotas temporales se pueden configurar, esto permite elegir la justificación de las líneas 
de cota sobre los objetos.  
 
Para configurar las dimensiones temporales siga estos pasos: 
 

1. Seleccionar pestaña Manage => Panel Settings =>  Additional Settings 

2. Seleccionar la opción Temporary Dimensions  
3. En el cuadro de dialogo seleccionar el modo de colocación de cota en muros, así 

como en puertas y ventanas.  
 

 
 

4. Confirmar y de clic en ok para cerrar el cuadro de dialogo y finalizar los cambios.  
 

Propiedades de vista 
 
Las vistas se usan para desplazarse por el modelo en Revit. Entre algunas de las 
propiedades que puede cambiar en una vista está, la escala, el nivel de detalle, estilo visual, 
orientación, nombre, entre otras.  
 
A continuación, se muestran las propiedades que se pueden cambiar en una vista: 
 



 

Nombre  Descripción 

Escala de vista  
(View Scale) 

Modifica la escala de la vista cuando esta aparece en el plano de dibujo. 
Seleccione un valor de escala en la lista.  

Valor de escala  
(Scale Value) 

Define un valor de escala personalizado. Esta propiedad está activada 
cuando se selecciona Personalizada para Escala de vista.  

Visualizar modelo 
(Display Model)  

Tiene tres opciones. Oculta el modelo en la vista de detalle, Normal: 
muestra todos los elementos normalmente, esta opción es para vistas que 
no son de detalle. Do not Display: muestra solo los elementos específicos 
de la vista de detalle, estos elementos comprenden líneas, regiones, 
cotas, texto y símbolos. Los elementos del modelo no se muestran. 
Halftone: muestra todos los elementos específicos de vista de modo 
normal y los elementos de modelo como Definir configuración de 
Subyacente/Tramado. Puede utilizar los elementos de modelo mostrados 
como tramado como referencia para trazar líneas, y realizar acotaciones y 
alineaciones.  

Modificaciones de 
visibilidad/gráficos  
(Visibility 
Graphics 
Overrides) 

Haga clic en Editar para acceder al cuadro de diálogo Modificaciones de 
visibilidad/gráficos.  
Nota: Si los valores del cuadro de diálogo se muestran en gris y no se 
pueden cambiar, es posible que una plantilla de vista defina las 
modificaciones.  

Estilo visual  
(Visual Style) 

Cambia la visualización.  

Orientación  
(Orientation) 

Alterna la orientación del proyecto en la vista entre el norte del proyecto y 
el norte real.  

Disciplina  
(Discipline) 

Determina cómo se muestran los elementos específicos de una disciplina 

en la vista. Este parámetro también puede utilizarse para organizar vistas 

en el Navegador de proyectos.  

Nombre de vista 
(View Name)  

Nombre de la vista activa. El nombre de la vista se muestra en el 
Navegador de proyectos y en la barra de título de la vista. También 
aparece como el nombre de la ventana gráfica en un plano, a menos que 
para el parámetro Título en plano exista un valor.   

Plantilla de vista  
(View Template) 

Identifica la plantilla de vista asignada a la vista. Los cambios posteriores 
en la plantilla de vista afectarán a la vista.  

Región de recorte 
visible (Crop 
View) 

Muestra u oculta la región de recorte. La visualización del recorte no está 
disponible en las vistas de plano o tabla de planificación.  

Rango de vista  
(View Range) 

En las propiedades de vista de una vista de plano, puede configurar el 
rango de la vista. Con esta opción puede controlar los planos geométricos 
específicos que definen los contornos de cada vista. Estos límites se 



Nombre  Descripción 

establecen definiendo el plano exacto de corte, así como los planos de 
delimitación superior e inferior.  

Fase (Phase) La fase específica de la vista. Junto con Filtro de fases, determina los 
componentes del modelo (en lo que respecta a la fase) que son visibles 
en la vista y el modo de mostrarse gráficamente. Cuando se crean otros 
componentes de un modelo en una vista, estos componentes adoptan la 
fase de la vista como su fase de creación.  

 

Propiedades de los objetos 
 
La paleta de propiedades es un cuadro de dialogo donde se puede visualizar, cambiar los 
parámetros de las vistas y objetos.  
Al seleccionar un objeto, se mostrarán las propiedades de los objetos en dos partes, las 
propiedades de tipo y las propiedades de ejemplar (instancia). 
 

 
 

• Selector de tipos: Muestra el listado de las familias y los tipos que están cargados 
en el proyecto. 

• Botón de tipos: El botón de editar tipo abre un cuadro de dialogo donde le permite 
ver las propiedades de tipo del elemento seleccionado, cualquier cambio hecho en 
este cuadro, se verá reflejado en todos los objetos que pertenezcan al mismo tipo 
sembrados en el proyecto. 

• Filtro de propiedades: Permite visualizar las categorías y el número de elementos 
de esta. Esto permite seleccionar la categoría deseada.  

• Propiedades de ejemplar: Cuando se modifica las propiedades de ejemplar los 
cambios que solo se ven reflejados en los objetos seleccionados.  

 
Ejemplo de propiedades de ejemplar: 
 

1. Reference Level: Muestra el nivel de referencia. 
2. Offset: Permite configurar el desfase con respecto al nivel. 
3. Diameter (Trade Size): Permite seleccionar el diámetro de la tubería. 



 

 
Ejemplo de propiedades de tipo: 
 

1. Electrical: Carga un estándar de tubería eléctrica. 
2. Fittings: Carga los componentes de la tubería. 
3. Identity data: Permite ingresar propiedades de identidad. 

 

 
 

Visibility Graphics (visibilidad de gráficos) 
 
La mayoría de las modificaciones de visualización de gráficos y visibilidad se realizan en el 
cuadro de diálogo Modificaciones de visibilidad/gráficos, excepto en el caso de las 



modificaciones en los elementos individuales, que se realizan en el cuadro de diálogo Ver 
gráficos de elementos específicos.  
 
Para abrir el cuadro de dialogo Visibility Graphics: 
 

1. Escoger pestaña View => Panel Graphics => Visibility Graphics 
 
Se describen a continuación las opciones del cuadro de dialogo Visibility Graphics. 
 

Propiedades de elementos categoría modelo 
 

1. Filter List: Muestra el listado de las disciplinas y las categorías que pertenecen a 
cada una. 

2. Visibility: Muestra y oculta las categorías en la vista.  
3. Projection/Surface: Permite cambiar las propiedades de los objetos que en la vista 

actual se ven en modo de superficie. 
4. Cut: Permite cambiar las propiedades de los objetos que en la vista actual se ven 

en corte. 
 

5. Halftone: Activada muestra en tono de grises los objetos de la categoría 
seleccionada. 

6. Detail Level: Permite seleccionar el nivel de detalle que tendrá la categoría 
seleccionada.  

7. Herramientas de selección: muestra las opciones de selección del listado de 
categorías. 

8. Object Styles: Permite administrar las propiedades de los objetos en todas las 
vistas del proyecto.  

 
 



Para cambiar la apariencia de color de una categoría de modelo siga estos pasos: 
 

1. Escoger Pestaña View => Panel Graphics => Visibility Graphics 
2. Activar pestaña Model Categories y hacer clic sobre la categoría que se requiere 

modificar 
3. Por ejemplo, para cambiar patrón de relleno de una categoría hacer clic en el botón 

Override bajo la columna Patterns. 
4. Asignar un color y un patrón para la categoría. 
5. Confirme los cambios, cierre el cuadro de dialogo para terminar los cambios.  

 

 
 

Propiedades de elementos categoría anotación 
 

1. Filter List: Muestra el listado de las disciplinas y las categorías que pertenecen a 
cada una. 

2. Visibility: Muestra y oculta las categorías en la vista.  
3. Projection/Surface: Permite cambiar las propiedades de los objetos que en la vista 

actual se ven en modo de superficie. 
4. Halftone: Activada muestra en tono de grises los objetos de la categoría 

seleccionada. 
5. Herramientas de selección: muestra las opciones de selección del listado de 

categorías. 
6. Object Styles: Permite administrar las propiedades de los objetos en todas las 

vistas del proyecto.  
 



 
 

Vista de corte, corte Multisegmento 
 
Las vistas de corte son proyecciones verticales que permiten ver el modelo a partir de una 
línea de corte, esta línea corta la geometría y con una dirección muestra la geometría. 
Dentro de la herramienta de corte hay un derivado, el corte, este es el multisegmento, este 
tipo de corte permite generar diferentes líneas de proyección a diferentes profundidades 
sobre el mismo corte de tal forma que se puedan apreciar diferentes partes del edificio. 
 

Vista de corte 
 
Para crear una vista de corte necesitara contar con un proyecto abierto donde pueda hacer 
uso de la herramienta.  
 

1. Seleccione la pestaña view => Panel Create => Herramienta o comando Section 
2. Marque un primer punto para el inicio del corte y un segundo punto para el segundo 

corte. 
 



 
3. Acceda al corte. De doble clic sobre el icono o simbología del corte. 

 

 
 

Cambio de rango de visualización de corte 
 
Todo corte generado cuenta con herramientas de visibilidad los cuales sirven para delimitar 
el rango visión. En vista de planta se mostrarán unas flechas de color azul con las cuales 
el usuario podrá controlar la profundidad y largo de corte como se muestra a continuación. 
 

 
 
Ejemplo de cambio de profundidad en el corte donde se realizó el cambio desde una vista 
de planta. 
 



 
 
En una vista de corte podrá seleccionar los puntos de control azul los cuales permiten 
modificar la visibilidad de corte en el sentido vertical. Seleccione los puntos de color azul y 
mueva los puntos de tal forma que cambie la visibilidad de la vista de corte.  
 

 
 

Vista de corte multisegmento 
 
La vista de corte multisegmento se forma a partir de una vista de corte existente, para 
generar el corte multisegmento siga estos pasos: 
 

1. Seleccione el corte que desea convertir en multisegmento. 
2. Seleccione la pestaña Modify => Panel Section => Comando Split Segment. 
3. Con la herramienta corte la línea de la sección de tal forma que designe el número 

de cortes y direcciones. 
4. Seleccione las flechas de color azul para controlar las líneas de corte 

multisegmento. 

 



Control de visibilidad en vista 
 
Revit permite controlar la visibilidad de las regiones en vistas mediante una serie de 
herramientas, estas se activan dependiendo de la vista activa. Estas herramientas son: 

• Crop View: Recorta la vista en dos dimensiones mediante un cuadro delimitador. 

• View Range: Controla los planos de corte de geometría en el sentido vertical. 

• Section Box: Recorta la geometría en una vista 3D 
 

Crop View 
 
Pasos para hacer uso de recorte de vista: 
 

1. En la paleta de propiedades, navegar hasta el grupo de parámetros Extents. 
2. Activar la casilla Crop Region Visible para mostrar el recuadro delimitante de corte. 
3. Activar la casilla del parámetro Annotation Crop para activar el recuadro 

delimitador de los elementos anotativos.  
 

 
 
 
 

View Range 
 
Pasos para hacer uso del rango de visión: 
 

1. En la paleta de propiedades, navegar hasta el grupo de parámetros Extents. 
2. En el parámetro View Range => seleccionar el botón Edit… 

 

 



Si necesita más información, consultar el botón <<Show donde le mostrara un gráfico junto 
con los colores que representa cada parámetro.  
 

 
 
 

3. Los valores que se pueden ajustar para controlar los rangos de visualización en una 
vista de planta o techo o techo son: 
 

• Top controla el tope del plano mayor. 

• Cut Plane: controla el plano de corte. 

• Bottom: controla el plano inferior. 

• View Depth controla el plano de profundidad.  
 
 
Los valores de los rangos deben de estar en congruencia de acuerdo al orden indicado la 
caja de dialogo Sample View Range, es decir, no deben de contraponerse en el orden que 
tienen asignado.  Es posible ajustar el nivel al que se encuentra asociado un plano de 
visualización. 
 
Ejemplo de cambio de valores en los parámetros del rango de visión: 
 
En la imagen a continuación el valor Cut plane se encuentra a 3.20 mts del piso del nivel, 
dejando ver claramente los sistemas de ductos que están modelados a la altura de plafón, 
El valor de Cut Plane nunca puede ser mayor al valor de Top, es por esa razón que Top 
está en 4 mts. 
 



 
 
En el ejemplo a continuación el valor Cut Plane está a 1.20 mts, dejando ver todos los 
objetos que se encuentran en una altura entre 0 y 1.20 mtrs del nivel. Este es el valor por 
defecto en las vistas de planta. 
 

 
 

Section Box 
 
Pasos para hacer uso de herramienta Section Box: 
 

1. Activar una vista 3D. En la paleta de propiedades, navegar hasta el grupo de 
parámetros Extents. 

2. Activar la casilla Section Box  
3. Con el cuadro delimitador, usar las flechas de control que se encuentran en cada 

cara de la caja para ajustar el tamaño de esta. 
 

 



 
Nota: Puede acceder a Visibility Graphics para ocultar la caja de la herramienta Section 
Box. Para esto: 
 

1. Abrir el cuadro de dialogo Visibility Graphics. 
2. Activar la pestaña Annotation Categories => seleccionar la categoría Section Box. 
3. Aplicar los cambios y cerrar el cuadro de dialogo.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  



Capítulo 2  
Plantillas de proyecto Mep 
 
Los archivos de plantilla (RTE) se utilizan para generar nuevos proyectos, puede trabajar 
con las plantillas por defecto incluidas en las librerías de Revit y personalizarlas para que 
cumplan con los estándares del proyecto. 
  

 
 
La plantilla de proyecto es un archivo que sirve como punto de partida para configuración 
de los estándares que se usan en todos los proyectos, en las plantillas se puede cargar 
familias, asignar propiedades a las categorías, preconfigurar las familias de sistema, 
establecer unidades de medida, grosores de línea, pie de planos etc.  
 

Crear una plantilla de proyecto 
 
Para crear un proyecto a partir de una plantilla: 
 
 

1. Escoger menú file => New => Project 
2. En el cuadro de dialogo en el apartado Template File seleccionar la plantilla 

deseada. 
 

 



 
3. También puede hacer clic sobre el botón Browse… para abrir la caja de dialogo 

selección de Template. 
 

 
 

4. Seleccionar la plantilla según la disciplina del proyecto, hacer clic en el botón Open. 
5. Clic en OK para terminar la creación del nuevo proyecto.  

 

Creación de nueva plantilla de proyecto en base a una existente: 
 

1. Escoger el menú file => New => opción Project 
2. Seleccionar una plantilla, en la casilla Template file o desde el botón Browse 
3. En la caja de dialogo Template file seleccionar la opción Project Template 

 

 
 

4. Clic en el botón OK, para crear la plantilla de proyecto. 
 

Guardar plantilla de proyecto 
 
Para guardar la plantilla de proyecto: 
 

1. Seleccione el menú file => Save as => opción Template  



2. En el cuadro de dialogo Guardar como… buscar y abrir la carpeta de destino 
3. Asignar el nombre del archivo de plantilla.  
4. En la casilla File of type, verificar que la extensión de archivo sea *.RTE. 

 

 
 

5. Clic en el botón save.  
 

Configuración de unidades generales 
 
Desde el cuadro de dialogo de unidades de medida se pueden modificar las unidades que 
están organizadas por disciplinas. 
 
Pasos para editar las unidades de medida: 
 

1. Escoger pestaña Manage => Panel Settings =>   Project Units  
2. Desplegar la casilla Discipline y escoger la disciplina a configurar. 

 

 
 

3. Dependiendo de la unidad escogida se mostrará un listado de unidades y formatos 
que pueden ser modificados según los requerimientos del proyecto, para cada 
disciplina. 

 
4. Clic en el botón OK para terminar la edición. 

 

Configuraciones mecánicas de Ductos (Para modelado)  
 
Para realizar configuraciones mecánicas: 
 

1. Escoger pestaña Manage => panel Settings => icono  Mep Settings => opción  

 Mechanical Settings. 
2. Bajo la sección Duct Settings se despliegan las opciones para configurar los 

sistemas de ductos. 



 
 
A continuación, se describen las opciones a configurar para los sistemas de ductos. 
 

Hidden line 
 
Configura la representación de las líneas ocultas cuando los ductos se entrecruzan, a 
continuación, los parámetros a considerar son: 
 

• Draw MEP Hidden Lines: Activa las preferencias de representación de líneas 
ocultas. 

• Line Style:  Define el estilo de línea que tendrán los ductos. 

• (1) Incide Gap: Especifica la separación de las líneas que hay en las intersecciones 
de los segmentos. 

 
• (2) Outside Gap: Especifica la separación de las líneas que en la parte exterior de 

los segmentos. 

• Single line: Especifica la separación de las líneas en la intersección de los 
segmentos.  

 

Duct Settings  
 
Al seleccionar la opción Duct settings, el panel derecho muestra un conjunto de parámetros 
comunes a todos los sistemas de ductos de un proyecto. 
 



Los parámetros que se pueden ajustar son: 
 
 

 

 
 
 

Angles ducts 
 
Al trazar los ductos, Revit usa los ángulos especificados en las configuraciones mecánicas. 
Hay tres modos de configuraciones para los ángulos de los ductos, estos son;  
 

• Use Any angle: Permite a Revit utilizar cualquier ángulo admitido por la unión 

• Incremento de Ángulo: Especifica el incremento de ángulo que Revit debe utilizar 
para determinar los valores de ángulo. 



• Ángulos específicos o correctos: Activa o desactiva ángulos específicos que 
Revit puede utilizar. 

 

Configuración de ángulos de ductos  
 
Para configurar los ángulos de los ductos: 
 

1. Abrir el cuadro de dialogo configuraciones mecánicas . 
2. En la sección Fitting angle, escoger la opción de configuración de ángulos requerida 

para el proyecto. 
 

 
 

3. Clic en el botón OK para aceptar los cambios. 
 

Conversion  
 
Las configuraciones realizadas en esta sección se activan cuando se utiliza la herramienta 
para hacer ruteo automático de los sistemas de ductos, las opciones a configurar son: 
 

• Especificar la altura base que tendrán los ductos principales y secundarios. 

• Indicar el tipo de ducto que usará cada sistema según la clasificación (suministro, 
retorno, extracción). 

• Máxima longitud de los ductos flexibles. 
 
Para cambiar las configuraciones de conversión: 
 

1. Abrir cuadro de dialogo de configuraciones mecánicas. 
2. Desplegar la casilla System Classification y seleccionar el sistema a configurar 

(Supply, Return, Exhaust). 
3. En las casillas Duct Type, tanto en el ramal principal como secundario establecer el 

tipo de ducto a usar. 
4. Asignar el desfase con respecto al nivel (altura desde el piso del nivel). 
5. Asignar la longitud máxima para los ductos flexibles. 
6. Presionar botón OK, para salir.  



 

 
 

Tamaños de ductos (Rectangular, Oval, Round)  
 
Los tamaños se asignan de acuerdo con las dimensiones de los conectores y las unidades 
de proyecto.  
 
Para crear tamaños de ductos: 
 

1. Abrir cuadro de dialogo de configuraciones mecánicas. 
2. Bajo Duct settings escoger la forma de ducto a configurar. 

 

 
 

3. Presionar botón New Size  
4. Ingresar el valor de tamaño a asignar 

 



 
 

5. Presionar el botón Ok para aceptar los cambios. 

 

Configuración y creación de tipos de ductos 
 
Los ductos son familias de sistema, y tienen tres formas; redondos, rectangulares, 
ovalados. Además, la configuración de los tipos de ductos implica configurar los accesorios 
que conectarán los tramos de ductos en los sistemas. 
  

Creación de tipos  
 
Pasos para crear tipos 
 

1. Seleccionar una familia de ducto en el navegador de proyectos. 
2. Clic derecho, en el submenú escoger opción Type Properties. 

 

 
 

3. En el cuadro de dialogo de propiedades de tipo seleccionar Duplicate o Rename 
4. Ingresar un nombre al tipo nuevo 

 



 
5. Confirmar los cambios, cierre el cuadro de dialogo y comprobar en el selector de 

tipos la existencia del nuevo tipo.  
 

 
 
 

Preferencias de ruteo de ductos 
 
Las preferencias de ruteo se configuran para determinar las familitas y tipos de accesorios 
que conectarán los tramos de ductos, estos accesorios son familias cargables. 
 
Configuración de componentes de ruteo (Fittings) de ductos: 
 

1. Seleccionar una familia de ducto en el navegador de proyectos. 
2. Clic derecho, en el submenú escoger opción Type Properties.  

 

 
 

3. En el cuadro de dialogo de Propiedades escoger el tipo de ducto a configurar. 
4. Bajo el grupo de parámetros “Fittings”, frente a la casilla Routing preferences 

hacer clic en el botón Edit… 
 



 
 

5. En el cuadro de dialogo Routing Preferences, configurar las familias de conectores 
que se usaran para el tipo de ducto seleccionado. 

 

 
 
Los accesorios para configurar dependen del tipo de unión (codo, conexión, cruz, transición, 
unión, tapón).  
 
Si más de una pieza para una unión cumple con los criterios durante la presentación, se 
utiliza la primera pieza que aparece. Puede desplazar una fila hacia arriba o hacia abajo 
para cambiar la prioridad de una pieza.  
 

6. En el cuadro de preferencias de ruteo seleccione el botón Load Family… para 
cargar las familias de conectores.  

7. Las familias de accesorios de conexión están en la carpeta Ducts / Fittings, se 
debe seleccionar la carpeta según la familia de ducto que se esté configurando.  

 



 
8. En cada parámetro donde solicite un componente, seleccione el desplegable y 

seleccione la familia que ira como preferencia de ruteo. 
 

 
 

9. Finalice la configuración, dar clic OK para cerrar las preferencias y las propiedades 
de tipo. 

10. Comprobar el funcionamiento trazando una trayectoria sin un sentido en específico. 
 

Creación de sistemas de clasificación de ductos 
 
Por defecto, existen tres tipos de sistemas de ductos: suministro de aire, aire de retorno y 
aire de extracción.  
 
Para crear un sistema de ductos: 
 

1. En el navegador de proyectos, seleccionar un tipo de sistema de ductos 
 



 
 

2. Clic derecho, en el submenú escoger opción Type Properties.  
3. En el cuadro de dialogo de propiedades de tipo seleccione Duplicate o Rename 
4. Ingresar un nombre para el nuevo tipo de sistema 
5. Puede cambiar la apariencia de color al nuevo sistema, haciendo clic sobre el botón 

Edit en la opción Graphic Overrides. 
 

 
 

6. Clic en el botón OK hasta salir del cuadro de dialogo de propiedades de tipo. 
 
 

Configuraciones mecánicas para tuberías hidráulicas (Para 
modelado) 
 
Para abrir el cuadro de dialogo configuraciones mecánicas: 
 

1. Escoger la pestaña Manage => panel Settings => icono  Mep Settings 

2. Escoger la opción Mecánica Settings  
3. Seleccionar la opción de configuración de tuberías “Pipe Settings”. 

 



 
 
Las opciones a configurar son: 
 

Ángulos de tubería (Angles) 
 
Al trazar tuberías, Revit usa los ángulos especificados en las configuraciones mecánicas, 
hay dos modos de configuraciones para tuberías, estos son; Ángulo libre y ángulos 
específicos. 
 
Para configurar los ángulos de tuberías: 
 

1. Abrir el cuadro de dialogo configuraciones mecánicas, en el listado de opciones 
escoger Pipe Settings. 
 

2. Escoger la configuración de ángulos. 
 

 
 

• User any angle: usar cualquier ángulo 

• Use especific angles: sólo usará el valor de ángulos especificado en el 
listado. 

 
3. Clic en el botón OK para aceptar los cambios y salir del cuadro de dialogo. 

 



Conversion  
 
Permite seleccionar el tipo de tubería que se usara para conectar los elementos de un 
sistema mediante el ruteo automático, tanto en el ramal principal como en el secundario. 
 
Configuración de la conversión para los sistemas de clasificación de tuberías: 
 

1. Abrir el cuadro de dialogo configuraciones mecánicas, desplegar la sección Pipe 
Settings. 

2. Escoger opción Conversion. 
 

 
 

3. En la casilla System Clasification seleccionar el sistema de clasificación a configurar  
 

 
 

4. Seleccionar el tipo de tubería a usar para el ramal principal en la sección Main. 
5. Seleccionar el tipo de tubería a usar para el ramal secundario en la sección Branch. 

 

 



 
6. En la casilla Offset especificar la altura de las tuberías con respecto al nivel. 
7. Presionar el botón Ok para salir del cuadro de dialogo.  

 

Segmentos de tubería (Segments and Sizes) 
 
Los segmentos de tubería se definen mediante catálogos clasificados por material. Cada 
catalogo tiene un listado de tamaños que puede modificarse según los requerimientos del 
proyecto. 
 
Para crear un segmento de tubería: 
 

1. Abrir el cuadro de dialogo configuraciones mecánicas, desplegar la sección Pipe 
Settings. 

2. Escoger opción Segments anda Sizes. 
3. En la casilla Segmet seleccionar el catálogo a usar como plantilla. 

 

 
 

4. Presionar el botón  Create New pipe segment.  
5. En el cuadro de dialogo de nuevo segmento, en la sección Create New, activar el 

parámetro Marial. 
 

6. En la casilla Material, hacer clic sobre el botón   para activar el cuadro de dialogo 
de materiales 

 

 
Para crear un nuevo material: 
 

7. En la caja de dialogo Material Browser, seleccionar un material del listado de 
materiales, preferiblemente que tenga características similares al material a 
configurar. 
 



 
 

8. Duplicar el material haciendo clic sobre el botón   Created and Duplicate 
materials. 

9. Activar la pestaña Graphics para modificar la apariencia grafica del material. 
 

 
 

10. Clic en el botón OK para cerrar el editor de materiales. 
11. En el cuadro de dialogo New Segment, en la casilla Schedule/Type seleccionar tipo 

de cedula que usara para el segmento de tubería. 
 

 



 
12. En la casilla Duplicate size catalog from, escoger el catálogo que usará para el 

segmento de tubería. 
13. Clic en el botón OK para terminar la creación del segmento 

 
Se crea un catálogo que tiene el material, cédula y tamaños de acuerdo a las 
configuraciones escogidas. 
 

 
 
 
Para crear un nuevo tamaño de tubería: 
 

1. En la caja de dialogo Segments and Sizes, en la sección Size Catalogo, 

presionar el botón  New Size. 
2. Ingresar los datos de diámetro nominal, interno y externo del nuevo tamaño de 

tubería. 
 

 
 

3. Presionar el botón OK. 
 
Nota: Un catálogo de tuberías debe incluir todos los tamaños que se van a usar en el 
proyecto, un tamaño de tubería que no esté definido en el catálogo no se podrá utilizar.  
 

Configuración y creación de tipos de tuberías  
 
Al crear tipos de tuberías es necesario definir las preferencias de ruteo, lo cual consiste en 
configurar los componentes que conectan los tramos de tuberías. 
  
Los tipos de tuberías se enlistarán en el apartado de familias opción “Pipe”, localizado en 
el navegador de proyectos. 
 



Para configurar los componentes (Fittings) de tuberías: 
 

1. Seleccione el tipo de tubería Default en el navegador de proyectos 
2. De clic derecho => de clic a Type Properties  

 

 
 

3. En cuadro de diálogo Type properties, bajo el grupo de parámetros Segmenta n 
Fittings, en la casilla Routing Preferences hacer clic en el botón Edit… 

 

 
 

4. Al hacer clic sobre el botón Load Family… puede cargar las familias de accesorios 
para tuberías. Por ejemplo, si está usando la librería US Metric, los accesorios están 
en la carpeta Pipe => Fittings. 

 

 
 



5. Bajo el grupo de parámetros Pipe Segment, primero se debe escoger el tipo de 
segmento a usar. Este se debe haber configurado previamente en la sección 
Segments and Sizes del cuadro de dialogo configuraciones mecánicas. 

 

 
 

6. Se puede modificar los tipos y familias de accesorios que se utilizarán para conectar 
los tramos de tubería, desplegando la casilla correspondiente al accesorio. 

 

 
 
Estos accesorios son: codos, tees, cruces, uniones, transiciones, tapones etc.  
 

7. En cada parámetro donde solicite un componente, seleccione el desplegable y 
seleccione la familia que ira como preferencia de ruteo. 

8. Clic OK para cerrar las preferencias y las propiedades de tipo. 
 

Creación de tipos de tuberías 
 
Para crear tipos de tuberías: 



 
1. Seleccionar un tipo de tubería en el navegador de proyectos. 
2. De clic derecho => en el submenú escoger Type Properties 
3. En el cuadro de dialogo de propiedades de tipo seleccione Duplicate 
4. Ingrese un nombre para el tipo nuevo. 
5. Hacer clic en el botón edit de la opción Routing preferences. 
6. Bajo el grupo de parámetros Pipe Segment, debe escoger el tipo de segmento a 

usar. Este se debe haber configurado previamente en la sección Segments and 
Sizes del cuadro de dialogo configuraciones mecánicas. 
 

 

 
 

7. Confirme los cambios, cierre el cuadro de dialogo y corrobore en el selector de tipos 
la existencia del nuevo tipo.  

 

 
 

 

Creación de sistemas de clasificación de tubería 
 
Pasos para crear un sistema: 
 



1. En el Navegador de proyectos, bajo la sección Families => Piping Systems 
 

 
 

2. Seleccione el sistema de clasificación base  
3. Clic derecho => en el submenú escoger Type Properties 
4. En el cuadro de dialogo de propiedades de tipo seleccionar Duplicate 
5. Ingrese un nombre al tipo nuevo 
6. Para cambiar las propiedades de color, y grosor de línea del sistema, hacer clic 

sobre el botón Edit… frente a la casilla Graphic Overrides. 
 

 
 

7. Asignar la información relacionada con el sistema.  
 



 
 
Los parámetros importantes para configurar son; Tipo de fluido, Temperatura de fluidos, y 
la simbología a usar para representar el cambio de dirección de los segmentos de tubería. 
 

Configuración eléctrica para circuitos, Conduit y charolas (Para 
modelado)  
 
Para acceder a las configuraciones eléctricas: 
 

1. Seleccione la pestaña Manage => panel Settings => desplegar icono Mep Settings 

2. Escoger opción  Electrical Settings. 
3. Se despliega el cuadro de diálogo Electrical Settings, que presenta todas las 

opciones de configuración necesarias para los elementos que serán parte de los 
sistemas eléctricos. 

 



 
 
 

Hide line 
 
En esta sección se configura la representación de las líneas ocultas cuando un conduit y 
charola se entrecruzan, los parámetros a configurar son: 
 

• Draw MEP Hidden Lines: Activa las preferencias de representación de líneas 
ocultas. 

• Line Style:  Defina el estilo de línea que tendrán los elementos. 

• Incide Gap: Especifica la separación de las líneas que hay en las intersecciones de 
los segmentos. 

 

• Outside Gap: Especifica la separación de las líneas que en la parte exterior de los 
segmentos. 

• Single line: Especifica la separación de las líneas en la intersección de los 
segmentos.  

 
En el siguiente ejemplo se muestra la representación gráfica de las líneas ocultas según la 
configuración especificada en la sección Hidden Line. 
 

  
 



 
 

General Electrical Settings 
 
Los parámetros para configurar establecen las propiedades de información y organización 
del cableado eléctrico. 
 
A continuación, se enlistan los parámetros del apartado General 
 

1. En el cuadro de dialogo configuraciones Eléctricas seleccionar opción General. 
2. Especificar las opciones según las configuraciones requeridas para el proyecto. 

• Electrical Connector Separator: especifica el símbolo utilizado para separar los 
valores del parámetro “datos eléctricos de los dispositivos”.  

• Electrical Data Style: especifica el estilo del parámetro Datos eléctricos de la 
paleta Propiedades de los componentes eléctricos:  

<Descripción del conector> <Voltaje> / <Número de polos> - <Carga>  

<Descripción del conector> <Voltaje> / <Fase> - <Carga>  

<Voltaje> / <Número de polos> - <Carga>  

<Voltaje> / <Fase> - <Carga>  

• Circuit Description: especifica el formato del parámetro Descripción de circuito en 
las propiedades de ejemplar del cableado.  

• Circuit Named by phase - Etiqueta de fase (A, B o C): estos valores solo se 
utilizan si se especifica la nomenclatura de circuito por fase para el grupo mediante 
la paleta Propiedades. A, B y C son los valores por defecto.  

• Capitalization for load names: especifica el formato parámetro Nombre de carga 
en las propiedades de ejemplar de circuitos.  
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• Circuit sequence: especifica la secuencia en la que se crean los circuitos de 
alimentación, lo que permite la creación de circuitos agrupados por fase.  

• Circuit Rating: especifica la potencia por defecto al crear circuitos en un modelo.  
• Circuit path offset: especifica el desfase por defecto al generar un camino de 

circuito.  

 

Angles  
 
Al trazar un conduit o charola, Revit usa los ángulos especificados en las configuraciones 
eléctricas. Hay tres modos de configuraciones para los ángulos, estos son; Libre Angulo, 
Incremento de Angulo, Ángulos específicos o correctos.  
 
Configuración de ángulos eléctricos 
 
Para configurar los ángulos eléctricos: 
 

1. En el cuadro de dialogo configuraciones Eléctricas seleccionar opción Angles. 
2. Especificar las opciones según las configuraciones requeridas para el proyecto, bajo 

la sección Fitting angle:  
 

• User any angle: usar cualquier ángulo 

• Use especific angles: sólo usará el valor de ángulos especificado en el 
listado. 

 
3. Clic en el botón OK para aceptar los cambios y salir del cuadro de dialogo. 

 

 
 
 

Wiring 
 
Permite determinar la representación del cableado. 
 
Para configurar los parámetros de cableado: 
 



1. En el cuadro de dialogo configuraciones Eléctricas seleccionar opción Wiring. 
2. Ajustar las configuraciones del cableado. 

 

• Temperatura ambiente: especifica la temperatura del entorno en el que se 
encuentran los cables.  

• Separación de cruce de cableado: permite especificar la anchura de la 
separación que se utiliza para mostrar los cables no conectados que se 
cruzan, como se muestra.  

 

 
 

• Marcas de cable: puede seleccionar el estilo de marca que se muestra en 
los conductores cargado, neutro y de tierra. Revit proporciona cuatro estilos 
de marca, como se muestra:  

 

 
• Línea inclinada a través de marcas: permite mostrar la marca del 

conductor de tierra como una línea diagonal que atraviesa las marcas del 
resto de conductores, como se muestra. 

 

 
 

• Mostrar marcas: determina si desea ocultar siempre las marcas, mostrarlas 
siempre o mostrarlas solo para los retornos. 

 

Wire Sizes 
 



Permite configurar las propiedades del cableado; de materiales, amperaje y recubrimiento 
para personalizar el listado de cables. 
 
Para crear un nuevo material: 
 

1. En el cuadro de dialogo configuraciones Eléctricas seleccionar opción Wire Sizes. 

2. Hacer clic sobre el botón  Add Material para crear un material en base a uno 
existente. 

 

 
 

3. Escoger el material base y especificar el nombre del nuevo material.  
 

 
 
Para agregar un nuevo valor de temperatura y aislamiento: 
 

1. Hacer clic sobre el botón  Add Temperature para seleccionar y agregar un valor 
de temperatura. 
 

 
 

2. Ingresar el nuevo valor de temperatura en la casilla Temperature Name, en la casilla 
Temperatura Base on; escoger cualquier temperatura base. 

 

 
 

 

3. Hacer clic sobre el botón  Add Insulation para seleccionar y agregar un valor de 
aislamiento. 

 



 
 

4. Ingresar el nuevo valor de aislamiento en la casilla Insulation Name: en la casilla 
Insulation Base on; escoger el valor de aislamiento base. 

 

 
 

Para crear un nuevo tamaño de cable: 
 

1. Presionar el botón New Ampacity 
2. En la caja de dialogo New Ampacity ingresar el valor de amperaje, tamaño y 

diámetro del nuevo segmento de cable. 
 

 
 

Correction Factor 
 
Permite configurar el valor de corrección en el cableado tomando en consideración la 
temperatura ambiente de la región. 
 
Para configurar los factores de corrección: 
 

1. En la casilla Material, seleccionar el material. 
2. En la casilla Temperature, seleccionar la temperatura. 

 



 
 

3. Hacer clic sobre el botón New Correction Factor, ingresar un nuevo valor de 
temperatura y factor de corrección. 

 

 
 
 

4. Con el valor Delete Correction Factor, se elimina un valor de corrección. 
 

Ground Conductors 
 
Permite configurar el tipo de cableado para tierra, incluyendo el amperaje y el tamaño del 
conductor.  
 
Para configurar los conductores a tierra: 
 

1. En la casilla Material, seleccionar el material del cableado. 
2. Hacer clic sobre el botón New Ampacity, ingresar un nuevo valor de amperaje y 

tamaño del conductor. 
 

 



 
3. El botón Delete Ampacity, permite eliminar el valor de amperaje seleccionado.  

 

Wiring Types 
 
En esta sección se configura los tipos de cable que se usaran en proyecto. Se deben definir 
las siguientes características: 

• Nombre: se trata de una cadena que identifica un determinado tipo de 
cable.  

• Material: permite seleccionar un material específico del proyecto, tal 
y como se ha definido en el cuadro de diálogo Material nuevo.  

• Estimación de temperatura: se debe escoger la temperatura a usar.  

• Aislamiento: se pueden especificar varios tipos de aislamiento, 
incluido un aislamiento específico del proyecto, tal y como se ha 
definido en el cuadro de diálogo insulation.  

• Tamaño máx.: Este parámetro permite escoger el tamaño de los 
cables.  

• Multiplicador neutro: se puede especificar la forma en que se ajusta 
el conductor neutro de un sistema. El valor especificado aquí se utiliza 
para aumentar o reducir el tamaño calculado del conductor neutro en 
función de un multiplicador de tamaño del conductor.  

• Requerido neutro: si se selecciona esta opción, todos los tramos de 
cableado con este tipo de cable incluirán un conductor neutro, incluso 
si se utiliza una carga equilibrada trifásica, donde es posible que la 
propia carga no necesite un conductor neutro. Si no se selecciona, se 
omitirá el conductor neutro para las cargas equilibradas y se incluirá 
para las cargas desequilibradas  

• Tamaño neutro: en este campo se puede especificar si el tamaño del 
conductor neutro se ajusta en función del valor de Tamaño de 
conductor cargado (la línea base del conductor neutro es la misma que 
la del conductor cargado) o del valor de Corriente no equilibrada (el 
conductor neutro se ajusta en función de la cantidad de corriente que 
fluye en este).  

• Tipo de tubo: el material del tubo afecta a la impedancia del cable y 
determina qué parte de la tabla de impedancia de cables se utiliza en 
los cálculos de caída de voltaje. Haga clic en el valor y, a continuación, 
seleccione Acero o No magnético.  

 



 
 
 
 
Nota: para crear correctamente un tipo de cable, previamente se deben haber configurado 
los parámetros en las secciones Wire Sizes, Correction factor, Ground conductor.  
 

Voltage Definitions 
 
En las Definiciones de voltaje se configuran los rangos de voltajes que se pueden asignar 
a los sistemas de distribución disponibles en el proyecto.  Cada definición de voltaje está 
especificada como un rango de voltajes para diferentes valores de voltaje en dispositivos 
de distintos fabricantes. Por ejemplo, dispositivos usados en un sistema de distribución de 
120 V pueden tener cualquier valor de entre 110 V y 130 V. 
 
Los parámetros para configurar son: 
 

• Name: identifica una definición de voltaje.  

• Value: es el voltaje real para la definición de voltaje.  

• Minimum: es el valor de voltaje más bajo para dispositivos y equipos eléctricos que 
se puede utilizar con la definición de voltaje.  

• Maximun: es el valor de voltaje más alto para dispositivos y equipos eléctricos que 
se puede utilizar con la definición de voltaje. 

 

 
 

Distribution Systems  
 
Permite configurar las propiedades de los sistemas de distribución que se necesitan para 
el proyecto. 
 



 
Nota: Para establecer los valores en los sistemas de distribución, previamente deben estar 
configurados los voltajes (Voltage definitions). 
 
Los valores a configurar en la distribución de sistemas son: 
 

• Name: Ingresar el nombre exclusivo que identifica un sistema de distribución.  

• Phase: Puede ser Trifásico o Monofásico. 

• Configuration: Sólo se activa cuando la fase escogida es para sistemas trifásicos.  

• wires: Este parámetro especifica el número de conductores (3 o 4 para trifásico, 2 
o 3 para monofásico).  

• Voltaje entre fases (L-LVoltage): Permite seleccionar una definición de voltaje que 
representa el voltaje medido entre dos fases. La especificación de este parámetro 
depende de las selecciones de Fase y Cable. Por ejemplo, Voltaje entre fases no se 
puede usar para un sistema monofásico de 2 cables.  

• L-G Voltage: Permite seleccionar una definición de voltaje que representa el voltaje 
medido entre una fase y tierra. L-T está siempre disponible.  

 

Cable Tray Settings  
 
Permite configurar las propiedades de anotación de las charolas. 
 

 
 

• Use Annot. Scale for Single Line Fittings: especifica si las uniones las charolas 
son visibles con el tamaño especificado por el parámetro Tamaño de anotación de 
unión de bandeja de cables.  

• Cable Tray Fitting Annotation Size: Específica el tamaño de unión de la charola 
cuando está en nivel de detalle básico (Coarse). Este tamaño se mantiene 
independientemente de cuál sea la escala de dibujo.  



• Cable Tray Size Separator: especifica el símbolo que se debe utilizar a la hora de 
mostrar tamaños las charolas. Por ejemplo, cuando se utiliza una X, una charola de 
12 pulgadas de altura y 4 pulgadas de profundidad se mostraría como 12" x 4".  

• Cable Tray Size Suffix: especifica el símbolo que se añade al tamaño de la charola.  

• Cable Tray Connector Separator: especifica el símbolo que se utiliza para separar 
información entre dos conectores diferentes.  

 

Rise Drop 
 
Permite configurar las representaciones simbólicas de la charola de acuerdo con la 
pendiente. 
 

 
 

• Cable Tray Rise/Drop Annotation Size: especifica el tamaño de los símbolos de 
subida/bajada dibujados en las vistas con nivel de detalle bajo.  Este tamaño se 
mantiene independientemente de cuál sea la escala del dibujo.  

• Single Line Symbology: especifica los símbolos de subida y bajada utilizados en 
las vistas donde las charolas se representan a una sola línea (nivel de detalle 
Coarse).  

• Two Line Symbology: especifica los símbolos de subida y bajada utilizados en las 
vistas donde las charolas se representan a dos líneas (nivel de detalle medio o fino). 

 

Size cable Tray 
 
En esta sección se crean los tamaños que se van a utilizar en el proyecto para modelar las 
charolas. 
 
Para crear tamaños de charolas: 
 

1. En el cuadro de dialogo de Configuraciones Eléctricas => Desplegar sección Cable 
Tray Settings => opción Size. 

2. Hacer clic sobre el botón New Size…  
3. Ingresar el valor del tamaño. 
4. Presionar el botón OK 

 



 
 

Conduit Settings 
 
Permite configurar las propiedades de anotación para los tubos Conduit 
 

 
 
 

• Use Annot. Scale for single Line Fittings: Activada permite visualizar las uniones 
de tubo.  

• Conduit Fitting annotation Size: especifica el tamaño de las anotaciones de las 
uniones de tubo en vistas donde los tubos Conduit se ven a una sola línea (nivel de 
detalle Coarse). Este tamaño se mantiene independientemente de cuál sea la escala 
del dibujo.  

• Conduit Size Prefix: especifica el símbolo que precede al tamaño de tubo.  

• Conduit Size Suffix: especifica el símbolo que se añade al tamaño de tubo.  

• Conduit Connector Separator: especifica el símbolo que se utiliza para separar la 
información entre dos conectores diferentes.  

 

Rise Drop cable Tray 
 
Permite configurar las representaciones simbólicas de la tubería Conduit. 
 



 
 
 

• Conduit Rise/Drop Annotation Size: especifica el tamaño de los símbolos de 
subida/bajada dibujados en las vistas con nivel de detalle bajo.  Este tamaño se 
mantiene independientemente de cuál sea la escala del dibujo.  

• Single Line Symbology: especifica los símbolos de subida y bajada utilizados en 
las vistas donde los tubos conduit se representan a una sola línea (nivel de detalle 
Coarse).  

• Two Line Symbology: especifica los símbolos de subida y bajada utilizados en las 
vistas donde los tubos conduit se representan a dos líneas (nivel de detalle medio o 
fino). 

 

Size Conduit 
 
En esta sección se configuran los estándares y tamaños de tubos Conduit. 
 
Para crear estándares y tamaños de tubo Conduit: 
 

1. En la casilla Standard hacer clic sobre el botón  Add Estándar 
 

 
 

2. Asignar un nombre al nuevo estándar 
3. Desplegar la casilla Standard Base On, escoger entre cualquiera de los estándares 

comerciales ya configurados, para utilizarlo como base, para el nuevo estándar. 
 
Los estándares incluidos en Revit incluyen un listado de tamaños más utilizados en el 
mercado, se pueden agregar nuevos tamaños. 
 



4. Presionar el botón OK. 
5. Presionar el botón New Size… 
6. Configure las propiedades del nuevo tamaño. 

 

 
 
Para cada tamaño de tubo, se especifica los siguientes parámetros:  
 

• Trade Diameter - Tamaño comercial  

• Inside Diameter - Diámetro interior (DI)  

• Outside Diameter - Diámetro exterior (DE)  

• Minimum Bend Radius: Radio de plegado mínimo  
 
 

Información de proyecto 
 
La información del proyecto se puede agregar a la plantilla de proyecto, dentro de los datos 
que se pueden añadir son: 
 
Datos de identidad: Datos de identidad de la organización y autor. 
Datos otros: Datos relevantes con respecto al proyecto, esta información puede cambiar de 
acuerdo con cada proyecto. 
 
Para colocar esta información, siga estos pasos: 
 

1. Seleccionar pestaña Manage => Panel Settings =>  
commando Project Information. 

2. Identifique el apartado Identity Data para agregar datos de la organización 
3. Identifique el apartado Other para colocar la información relevante al proyecto 

 



 
 

Familias cargables 
 
las familias cargables se crean en archivos RFA externos y se importan a los proyectos o 
plantillas. 
 
Para cargar familias cargables: 

1. Escoger pestaña Insert => Panel Load From library => opción  Load Family 
2. Seleccionar las familias a cargar. 

 

 
 

3. Clic en Open para cargar las familias al proyecto o plantilla. 



4. En el navegador de proyectos se puede revisar las familias cargadas. 
 
 

 
 

Importación de archivos CAD 
 
Puede importar o vincular datos de otros programas de CAD a un modelo de Revit y además 
es posible controlar diversos aspectos del proceso, como por ejemplo colores, capas y 
posición. 
 
Las opciones que se deben considerar para importar un archivo CAD se muestran en la 
caja de dialogo Import CAD, y se indican a continuación: 
 
Current view only: Cuando está activo, importa un dibujo de CAD solo en la vista activa y 
los elementos se comportan como anotaciones. Si la opción no está seleccionada, la 
importación se comporta como geometría de modelo y está disponible en todas las vistas.  
 
Colors: Tiene tres opciones: 
 

• Invert: Invierte los colores de todos los objetos de texto y de línea del archivo 
importado a colores específicos de Revit. Los colores oscuros se vuelven más claros 
y los colores claros se vuelven más oscuros. Esto puede mejorar la legibilidad 
cuando el archivo se encuentre en Revit.  

 

• Preserve: Mantiene los colores definidos en el archivo importado. Los colores RGB 
se importan como colores de índice y se convierten a color RGB. Es posible que los 
colores RGB no coincidan completamente con el archivo original.  

 

• Black and White: Importa el archivo en blanco y negro. 
 
Layers/Levels: Tiene tres opciones: 
 

• All: Importa o vincula todas las capas. Las capas que no estén visibles en el vínculo 
se desactivarán en la vista actual de Revit. 

 

• Visible: Importa o vincula todas las capas visibles. 
 



• Specify: Permite seleccionar las capas y niveles que se van a importar o vincular 
(en el cuadro de diálogo que se muestra). Las capas que no se seleccionen se 
suprimirán.  

 
 
Si más adelante desea vincular las capas omitidas, deberá suprimir el vínculo y volver a 
vincular el archivo.  
 
Import units: Establece de forma explícita la unidad de medida de la geometría importada. 
Los valores son Auto detectar, pies, pulgadas, metro, decímetro, centímetro, milímetro y 
Factor personalizado.  
 
Al escoger Auto detectar para un archivo de AutoCAD creado con unidades imperiales 
(sistema inglés), el archivo se importa tomando como unidades los pies y las pulgadas. Si 
el archivo de AutoCAD se crea con unidades métricas, se importa a Revit tomando como 
unidades los milímetros.  
 
Si se importa un archivo en un proyecto con unidades opuestas, por ejemplo, un archivo 
con sistema métrico en un proyecto con sistema imperial, prevalecen las unidades del 
proyecto principal.  
 
Si el archivo importado tiene una unidad personalizada, seleccione “Custom factor” en 
Unidades de importación. De esta forma, se habilitará el cuadro de texto adyacente a la 
lista de selección para que pueda introducir un valor de escala.  
 



 
 
Supongamos que el archivo tiene una unidad llamada "widget", que equivale a 10 metros. 
Al importar el archivo, seleccione Custom factor: en Unidades de importación y especifique 
un valor de 10 en el cuadro de texto adyacente. Cada unidad del archivo de origen equivale 
ahora a 10 metros en el archivo de Revit.  
El valor que indique aquí se mostrará en la propiedad de tipo Factor de escala del símbolo 
de importación.  
Si se trata de unidades conocidas, puede elegir Factor personalizado e indicar un factor de 
escala. Esto puede aumentar o reducir el tamaño de los elementos importados a Revit.  
 
Correct lines that are slightly of axis: Esta opción, activada por defecto, corrige 
automáticamente las líneas que están ligeramente fuera del eje (menos de 0,1 grados) y 
ayuda a evitar problemas relacionados con los elementos de Revit generados a partir de 
dichas líneas. Es posible que desee desactivar esta opción cuando realice una importación 
o vinculación de topografías. 
 
Posición: Permite especificar el modo en que la geometría importada se coloca respecto 
al modelo anfitrión. Las opciones de posicionamiento de tipo automático pueden usarse si 
se conoce la posición de las coordenadas del modelo anfitrión y las del archivo importado 
o vinculado. Las opciones de posicionamiento de tipo manual permiten colocar la geometría 
importada según un punto específico definido en el archivo importado o vinculado. Estas 
opciones ofrecen control directo de la posición de la geometría entrante en el modelo 
anfitrión.  
 
Las opciones de posicionamiento son: 
 

• Auto Center to Center: coloca el centro de la geometría importada en el centro del 
modelo anfitrión de Revit. Tanto en la geometría importada como en el modelo 
anfitrión, el centro geométrico se calcula hallando el centro de un cuadro de 
delimitación alrededor de la geometría.  

 
En la imagen se observa la coincidencia del centro de la geometría importada y la geometría 
del anfitrión:  
 

 
 



 
 
No utilice Automático - Centro a centro si debe repetir la importación de un archivo o 
importar varios archivos en el modelo anfitrión. Esta opción determina el centro en función 
de la geometría en el momento de importar o vincular el archivo. 
 

• Auto Origin to Origin: Seleccione esta opción para colocar el origen de la 
geometría importada en el origen del modelo anfitrión de Revit. En un modelo de 
Revit, el origen se denomina también origen interno. Al crear un proyecto de Revit, el 
punto base del proyecto corresponde al origen interno.   

 
Importante: El punto base del proyecto se puede desplazar de modo que deje de 
corresponder al origen interno. 
 
En la imagen: 
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Use Automático - Origen a origen si debe utilizar un punto común para coordinar la posición 
de varios vínculos o importaciones. Los puntos de origen del modelo anfitrión y la geometría 
entrante se mantienen constantes, sea cual sea la geometría en cada archivo. 
 

• Manual Origin: Seleccione esta opción para mostrar la geometría importada en la 
vista actual, con el cursor colocado en el origen universal de la importación o el 
vínculo. 

 

• Manual Center: Seleccione esta opción para mostrar la geometría importada en la 
vista actual, con el cursor colocado en el centro geométrico de la importación o el 
vínculo. 

 
Para importar archivos DWG: 
 

1. Abrir el proyecto en la cual se requiere importar el archivo CAD 
2. Activar la vista en la cual se importará el archivo CAD 

 

3. Escoger pestaña Insert => panel Import =>  
4. Buscar y seleccionar el archivo a importar 
5. En la caja de dialogo Import CAD Formats, escoger las opciones según las reglas 

de importación a aplicar. 
 



 
 

6. Escoger la opción Open para importar la geometría. 
 

Manejo de archivos importados 
 
Al importar un dibujo a Revit, se importan con él todos sus elementos, entre ellos bloques 
y referencias externas (xrefs) del dibujo. Esos elementos se encuentran dentro de un 
elemento denominado símbolo de importación. 
 
Al seleccionar el símbolo importado (Archivo CAD), se puede consultar información acerca 
de los elementos para ver sus propiedades. 
 
Para ver las propiedades de los elementos de un símbolo importado: 
 

1. Seleccionar símbolo importado. 

2. En la pestaña Contextual Modify => panel Import Instance => escoger icono   
(Query). 

3. Hacer clic sobre el elemento a consultar. 
 



  
 

4. Se muestran las propiedades el elemento CAD 
 

 
 
Para borrar capas de un símbolo importado: 
 

1. Seleccionar símbolo importado 

2. En la pestaña Contextual Modify => panel Import Instance => escoger icono   
(Query) 

3. Seleccionar las capas a borrar en el listado que aparece en el cuadro de dialogo 
Select Layers/Levels to Delete 

 
 
 



 
 

4. Presionar el botón Ok para salir del cuadro de dialogo. 
 
Descomponer geometría importada: Es posible descomponer el símbolo de importación, 
puede escoger entre dos opciones: 
 

• Full Explode: permite obtener directamente texto, curvas, líneas, bloques y 
regiones rellenadas de Revit.  

 

• Partial Explode: Una descomposición parcial de un símbolo de importación produce 
otros símbolos de importación que, a su vez, pueden descomponerse para producir 
elementos u otros símbolos de importación. Se trata de una operación similar a la 
descomposición en AutoCAD con bloques y referencias externas. No es posible 
descomponer archivos vinculados ni símbolos de importación compuestos por más 
de 10.000 elementos. 

 
Para descomponer geometría importada: 
 

1. Seleccionar símbolo importado 
2. En la pestaña Contextual Modify => panel Import Instance => desdeplar icono 

  (Explode) 
3. Escoger Full Explode o Partial explode. 

 
 

  



Capítulo 3  
 

Sistemas Hvac 
 
Los elementos que van a formar parte del sistema de hvac se encuentran clasificados en 
diferentes categorías; Equipos mecánicos, Terminales o rejillas de aire, Accesorios de 
ducto. Estos elementos se encuentran definidos en familias cargables. 
 

Colocación de familias mecánicas 
 
Para cargar familias de elementos mecánicos: 
 

1. Abrir un proyecto y activas la vista donde se van a colocar los elementos 
2. Seleccione la pestaña Insert => Panel Load From Family => Load Family. 
3. Si está usando la librería US Metric, buscar la carpeta Electrical/Mep 

 

 
 
4. Escoger pestaña Systems => panel Mechanical, HVAC,  
5. Según la categoría en la que se encuentre el elemento a insertar debe escoger el    
     comando Duct Accesories, Aire Terminal, Mechanical Equipment. 

 
6. En el selector de tipos, escoger familia y el tipo a utilizar. 
 

 
 



7. Colocar la familia sobre el área de dibujo 

 

Propiedades básicas de familias mecánicas 
 
Para modificar las propiedades básicas de familias mecánicas es necesario abrir el editor 
de familias, ya que estos estos elementos están definidos en familias cargables.  
 
Editar familia mecánica 
 

1. Abrir el editor de familias el archivo a editar 
2. Realizar las modificaciones requeridas a la geometría de la familia.  
3. Guardar los cambios en la familia editada 

 

Propiedades de conector de familias mecánicas 
 
Para cambiar alguna propiedad de la familia mecánica, identifique el conector que desea 
editar.  
 

1. Abra la familia mecánica en la sesión del programa  
2. Identifique los parámetros o propiedades del conector de ducto 
3. Cambie la propiedad deseada, guarde y cierre la familia 

 

 
Propiedades del conector ducto 
 
Para poder modificar las propiedades del conector de ducto deberá contar con una familia 
mecánica abierta en la sesión del programa. Seleccione el conector y cambie la propiedad 
que necesite modificar.  
 
A continuación, se muestran los parámetros más importantes del ducto. 
 
 



 
 

A. Shape: Permite seleccionar y modificar la forma del conector (Ducto Redondo, 
rectangular u ovalado)  

B. Dimensiones: Permite cambiar las dimensiones del tamaño del conector 
C. System Classification: Permite asignar un sistema de clasificación al conector 
D. Connector Description:  Permite asignar una breve descripción al conector 

 

Modelado de Ductos  
 
Los sistemas de ducto se pueden modelar de forma manual o automática. Al modelar de 
forma manual se deben colocar los elementos que serán parte del sistema cómo; terminales 
de aire, equipos y luego conectarlos dibujando los tramos de ductos. En el caso del ruteo 
automático los ductos se crean automáticamente conectando los equipos y terminales de 
aire que deben haberse colocado previamente en la vista. 
 

Trazado de ducto  
 
Pasos para trazar un ducto horizontal: 
 

1. Seleccione pestaña Systems => panel HVAC =>  (Duct).   
2. En el selector de tipos, seleccione la familia y tipo a usar.  
3. En la barra de opciones o en las propiedades de instancia ajuste el tamaño del 

ducto. 
 

 
 

4. Establezca el nivel de referencia en las propiedades de instancia. 
5. En la barra de opciones o en las propiedades de instancia ajuste el desfase con 

respecto al piso del nivel (offset). 



 
 

6. Marcar un primer punto en el área de dibujo 
7.  Marcar un segundo punto para terminar el primer tramo de ducto.  
8. Para cambiar de dirección marcar un tercer punto. 
9. Finalice la creación, de clic en el botón Modify. 

 

 
 

Trazar ducto vertical: 
 
Para trazar un ducto vertical (opción 1) 
 

1. Seleccione un ducto, equipo o terminal de aire. 
2. Clic derecho sobre el conector a partir del cual va a comenzar a dibujarse el ducto. 

 



 
 

3. En el submenú seleccionar Draw Duct 
4. En la barra de opciones en la casilla offset ingresar el valor de desfase final (end 

offset)  
 

 
5. Seleccione el botón Apply para efectuar los cambios 
6. Seleccione el botón Modify para terminar la creación del ducto  

 
Pasos para trazar un ducto vertical (opción 2) 
 

1. Crear y abrir una vista de corte. 
 
La dirección de la vista de corte debe facilitar la visualización de los elementos que son 
necesarios para generar el tramo de ducto vertical. 

 
 

2. Seleccionar un ducto y dar clic derecho sobre el conector. 
3. En el submenú seleccionar Draw Duct 



 
4. Dibujar el ducto hacia la dirección deseada 

 

 
5. Seleccione el botón Modify para terminar la creación del ducto  

 

Conexión de ductos con rejillas o equipos del sistema 
 
Para conectar ductos a rejillas o equipos del sistema en una vista de planta: 
 

1. Identificar el ducto y rejilla que requiere conectar. 

 
 

2. Seleccionar el conector del ducto, arrastrar hasta que coincida con snap del 
conector del equipo o rejilla a conectar.  



 
3. Finalice la conexión, de clic al botón Modify 

 
Para conectar ductos a rejillas o equipos del sistema en una vista de corte: 
 

1. Identifique el ducto y la rejilla que desea conectar. 

 
 

2. Crear o activar a una vista de corte donde pueda visualizar al ducto y el elemento a 
conectar. 

 
3. Seleccionar el equipo o rejilla, de clic derecho al conector. En el menú contextual 

seleccione la opción Draw Duct.  
 



 
 

4. Trazar el ducto a partir del conector del equipo o rejilla. En el ejemplo de la imagen; 
se observa que el ducto conectado a la rejilla debe ser vertical. 
 

 
5. Cambiar la dirección del puntero para crear el nuevo tramo horizontal, buscando el 

punto que alinea el centro del ducto que sale de la rejilla con el tramo horizontal al 
que se requiere conectar.  

 
6. Finalizar el comando. Clic en el botón Modify 

 
 
 

Duct Placeholder (Marcador de posición de ductos) 
 
Se puede utilizar en las primeras fases del diseño para indicar la ubicación aproximada de 
un tramo de ducto o para mostrar un diseño cuyo tamaño no se haya ajustado 
completamente. Este marcador se muestra como una geometría de una sola línea sin 



uniones. El uso de un marcador de posición de ducto puede permitir la correcta conexión 
del sistema, aunque de momento de desconozca el diseño, que se puede ajustar en una 
fase posterior del proceso de diseño, pues puede convertir un marcador de posición de 
ducto en un ducto con uniones. 
 
Para crear un placeholder: 
 

1. Activar una vista de planta 

2. Escoger pestaña System => panel HVAC => icono  (Duct placeholder) 
3. En el selector de tipos en la paleta de propiedades, escoge el tipo de ducto que se 

usará para la representación 
4. Definir el tamaño del ducto que se usará para la representación 
5. Definir altura desde del piso del nivel 

 

 
 

6. Especificar el tipo de sistema al que pertenece  
7. Dibujar los segmentos de línea que representan los ductos 

 



 
 

Opciones de conexión de placeholder 
 
Cuando se encuentra seleccionada la herramienta de Marcador de posición Revit muestra 
las siguientes opciones:  
 

• Conexión automática : conecta automáticamente a los forzados de 
cursor de un componente al iniciar o finalizar un segmento de conducto. Esta opción 
es útil para conectar segmentos en elevaciones diferentes. Sin embargo, al dibujar 
un ducto a lo largo de la misma ruta que otro ducto con un desfase diferente, se 
debe desactivar la opción para evitar la creación involuntaria de una conexión.  
 

• Inherit Elevation (Heredar elevación): hereda la elevación del elemento al 
que se aplica el forzado de cursor.  
 

Para heredar elevación: 
 

1. Activar el comando Duct placeholder 
2. Definir el tamaño del ducto 
3. Activar la opción Inherit Elevation 
4. Definir el primer punto del placeholder sobre el extremo del segmento del cual 

se requiere heredar elevación. 
 



 
 

5. Definir el segundo punto. 
 

• Inherit Size  Heredar tamaño: hereda el tamaño del elemento al que se aplica 
el forzado de cursor.  

 
Para heredar tamaño: 
 

6. Activar el comando Duct placeholder 
7. Definir la elevación del ducto 
8. Activar la opción Inherit Size 
9. Definir el primer punto del placeholder sobre el extremo del segmento del cual 

se requiere heredar el tamaño. 
 

 
 

10. Definir el segundo punto. 
 
 

Convertir un marcador de ducto en un ducto 
 



 
 

1. Seleccionar el marcador de ducto 
 

 

2. En la pestaña Modify Duct Placeholder => panel Edit => escoger icono  
(Conver Placeholder) 
 

Modelado automático de Ductos 
 
Para modelar un sistema básico de aire acondicionado mediante ductos necesitara los 
siguientes componentes: 
 

• Unidad de paquete: La unidad de paquete es la encargada de emitir y recibir aire, 
esta suministra y recoge el aire.  

 

• Ducto: Son los medios geométricos que hace llegar de la unidad de paquete a las 
rejillas, mismas que están localizadas en los espacios.  

 

• Rejilla: Son la parte final de la ingeniería, estas son las encargadas de distribuir el 
aire que proviene de los ductos, estas rejillas se colocan en los espacios.  
 

 
Esquema grafico 
 



 
 

1. Unidad de paquete 
2. Ducto 
3. Terminal de aire 

 
Nota: Todas las familias que compone la ingeniería tienen el conector de ducto. 
 

 
 

Creación de sistemas de ductos 
 
Para crear un sistema de ductos, es necesario que los sus componentes tengan en común 
la clasificación del sistema de los conectores. 
 
Para crear un sistema de ductos: 
 

1. Colocar los componentes del sistema (equipos, terminales de aire). 
 



 
 

2. Seleccionar cualquiera de los elementos que serán parte del sistema, por ejemplo; 
una rejilla de aire. 

3. En la pestaña contextual Modify seleccionar el botón  Duct – Create 
Systems. 

4. Definir el tipo de sistema a crear e Ingresar el nombre del nuevo sistema 
 

 
 
Se puede activar la opción Open in System Editor, para que se abra automáticamente el 
editor de sistemas. 
 

5. Presionar el botón OK, para crear el sistema. 
 
Para editar un sistema: 
 

6. Seleccionar cualquier elemento que pertenezca al sistema a editar. 

7. En la pestaña Duct System seleccione el botón  Edit System  
 

8. Activar el icono   Add to System para agregar otros elementos.  
 

9. El icono   Remove From System permite remover un elemento del sistema.  
 



 

10. Activar el icono   Select Equipment para añadir la unidad de paquete o algún 
otro equipamiento. 

11. Presionar el icono  Finish Editing System, para la edición del sistema. 
 
 

Ruteo automático de ductos en un sistema 
 
Para generar un sistema de ductos de forma automática, se debe considerar: 
 

• Conectores: los conectores deben de contar con la misma clasificación de sistema. 

• Ruteo de componentes: los ductos deben de contar con preferencias de ruteo 
definido en la caja de dialogo Mechanical Settings, opción Conversion, así como ser 
asignado al sistema de clasificación en las propiedades mecánicas.  

• Diseño: El diseño generado de forma automática debe contar con un criterio y debe 
ser avalado por un especialista.  

 
Para crear el ruteo automático de ductos: 
 

1. Crear un sistema de ductos. 
2. Seleccionar cualquier objeto que pertenezca al sistema, y que tenga un conector de 

la clasificación que se requiere crear. 
 

3. En la pestaña Modify => escoger icono  Generate Layout. 
4. Se podrá observar una previsualización del ruteo de los ductos en la vista. 

 

 
 
 

5. en la barra de opciones, puede escoger cualquiera de las soluciones sugeridas por 
Revit. (Network, Perimeter, Intersections).  



 

 
 
Los controles que se despliegan del lado derecho de la casilla Solution Type, permiten 
navegar a través de las opciones de soluciones que proporciona Revit. Cada Tipo de 
solución puede contener una o varias propuestas. 
 

6. Con el botón Settings es posible revisar la configuración de Conversion para el 
tipo de ducto que se usara para el ramal principal y secundario, además la altura 
(offset) de los ductos con respecto al nivel. 

 

 
 

7. Presionar el botón OK, para salir del cuadro de dialogo Duct conversión Settings. 
 

Para revisar opciones de ruteo: 
 
Después de revisar las configuraciones se debe observar que las líneas que representan 
los ductos se muestren en color azul (tramos principales), y verdes (tramos secundarios). 
En caso de que se observen segmentos de línea en color naranja indica que existe un 
conflicto y Revit no puede resolver estas conexiones, lo cual puede deberse a varios 
motivos: 
 

• Las diferencias de altura entre los ductos principales y secundarios son muy 
estrechas, y los accesorios no pueden ser conectados correctamente. 

• Algunos elementos del sistema están muy cerca, por lo tanto, los accesorios no 
pueden ser conectados correctamente. 

• El ancho de los ductos no permite una transición correcta para conectarse. 

• Los elementos para conectar están desalineados o en ángulos que el sistema 
no puede resolver. Etc. 

 



 
 
Para modificar el diseño de las opciones de ruteo: 
 

8. Seleccionar una de las soluciones de ruteo. 
 

 
 

9. En la pestaña contextual Generate Layout => Escoger icono    Edit Layout  
10. Seleccionar el tramo o tramos de ducto a desplazar. 

 

 
 
Revit creará una solución llamada Custom 
 

11. Clic en el icono   (Finish Layout) para crear los ductos. 



 

Conversión de ducto metálico por ducto flexible 
 
Para convertir ductos metálicos rígidos a ductos flexibles, siga estos pasos: 
 

1. Identifique la terminal de aire que está conectada con un ducto metálico rígido 
2. Seleccione la pestaña Systems => Panel HVAC => Comando Convert to flex Duct 

 
3. Seleccione en la barra de opciones la distancia de longitud del ducto flexible 

 
4. Seleccione la terminal de aire para convertir los ductos conectados a la misma a ducto 
flexible 

 
 



Capítulo 4  
 

Sistemas Hidráulicos  
 

Colocación de familias mecánicas, hidráulicas y PCI 
 
Para cargar familias de elementos de plomería: 
 

1. Abrir un proyecto y activas la vista donde se van a colocar los elementos 
2. Seleccione la pestaña Insert => Panel Load From Family => Load Family. 
3. Si está usando la librería US Metric, buscar la carpeta Plimbing/Mep/Fixtures 

 

 
 
4. Escoger pestaña Systems => panel Plumbing & Piping  
5. Según la categoría en la que se encuentre el elemento a insertar debe escoger el 
comando Pipe accesories, Plumbing Fixture, Sprinkler. 

 
6. En el selector de tipos, escoger familia y el tipo a utilizar. 
 

 
 
7. Colocar la familia sobre el área de dibujo 



 
 

Propiedades básicas de familias hidráulicas  
 
Es posible modificar los conectores de tubería en las familias de plomería, se puede cambiar 
el sistema de clasificación, tamaño de conexión y flujo de líquido.  
 

Editar familia Plomería  
 
Los elementos de plomería están definidos en familias cargables, es necesario modificar 
las propiedades de los conectores en el editor de familias. 
 
Para editar una familia de plomería: 
 

1. Seleccionar el objeto en una vista del proyecto. 
 

 

2. Seleccione la pestaña Modify => Botón  Edit Family 
3. Se abre el editor de familias. En esta interfase de puede modificar todas las 

propiedades cómo, geometría, conectores, parámetros etc. 

4. Escoger Menú File => Save  para guardar los cambios realizados en la 
familia. 

5. Cargar la familia al proyecto usando cualquiera de las dos opciones  



Propiedades los conectores para tuberías 
 
Las propiedades que tiene el conector de tuberías son las siguientes: 
 

1. Diameter o Radius: Permite asignar las dimensiones del conector de la tubería.  
2. System Classification: Permite seleccionar el tipo sistema al que pertenecerá el 

conector, por ejemplo; a un sistema de agua fría, agua caliente, protección contra 
incendios etc. 

3. Flow: Permite ingresar el flujo del líquido, si está usando el sistema métrico, la 
medida por default será L/S.  

4. Connector Description: Permite colocar una descripción del conector para 
diferenciarlo de otros conectares que están vinculados al mismo elemento de 
plomería. 

 

   
 
Nota: El primer conector siempre tendrá un distintivo en forma de “X” para diferenciarlo de 
los demás conectores secundarios. 
 

Modelado de tuberías  
 
Para modelar las tuberías siga a continuación los siguientes pasos: 
 

1. Seleccione la pestaña Systems => Panel Plumbing & Piping => Pipe 
2. Seleccione en el selector de tipos el tipo de tubería deseado 
3. En la barra de opciones seleccione el diámetro y el offset con respecto al nivel que 

se está colocando.  

 



4. Marque un primer punto para marcar el inicio de la tubería 
5. Marque un segundo punto para marcar el punto final o cambio de dirección de la tubería 
6. Realice cambios de dirección en sentido horizontal.  
 

 
 

Duct Placeholder (Marcador de posición de tuberías) 
 
Se puede utilizar en las primeras fases del diseño para indicar la ubicación aproximada de 
un tramo de tubería o para mostrar un diseño cuyo tamaño no se haya ajustado 
completamente. Este marcador se muestra como una geometría de una sola línea sin 
uniones. El uso de un marcador de posición de tuberías puede permitir la correcta conexión 
del sistema, aunque de momento de desconozca el diseño, que se puede ajustar en una 
fase posterior del proceso de diseño, pues puede convertir un marcador de posición de 
tuberías en una tubería con uniones. 
 
Para crear un placeholder: 
 

8. Activar una vista de planta 

9. Escoger pestaña System => panel HVAC => icono  (pipe placeholder) 
10. En el selector de tipos en la paleta de propiedades, escoger el tipo de tubería que 

se usará para la representación 
11. Definir el tamaño de la tubería  
12. Definir altura desde del piso del nivel 

 



 
 

13. Especificar el tipo de sistema al que pertenece  
14. Dibujar los segmentos de línea que representan las tuberías 

 

 
 

Opciones de conexión de placeholder 
 
Cuando se encuentra seleccionada la herramienta de Marcador de posición Revit muestra 
las siguientes opciones:  
 



• Conexión automática : conecta automáticamente a los forzados de 
cursor de un componente al iniciar o finalizar un segmento de conducto. Esta opción 
es útil para conectar segmentos en elevaciones diferentes. Sin embargo, al dibujar 
un ducto a lo largo de la misma ruta que otro ducto con un desfase diferente, se 
debe desactivar la opción para evitar la creación involuntaria de una conexión.  
 

• Inherit Elevation (Heredar elevación): hereda la elevación del elemento al 
que se aplica el forzado de cursor.  
 

Para heredar elevación: 
 

11. Activar el comando pipe placeholder 
12. Definir el tamaño de la tubería 
13. Activar la opción Inherit Elevation 
14. Definir el primer punto del placeholder sobre el extremo del segmento del cual 

se requiere heredar elevación. 
 

 
 

15. Definir el segundo punto. 
 

• Inherit Size  Heredar tamaño: hereda el tamaño del elemento al que se aplica 
el forzado de cursor.  

 
Para heredar tamaño: 
 

16. Activar el comando pipe placeholder 
17. Definir la elevación de la tubería 



18. Activar la opción Inherit Size 
19. Definir el primer punto del placeholder sobre el extremo del segmento del cual 

se requiere heredar el tamaño. 
 

 
 

20. Definir el segundo punto. 

 

Convertir un marcador de tubería en una tubería 
 

1. Seleccionar el marcador de tubería 
 

 

2. En la pestaña Modify Pipe Placeholder => panel Edit => escoger icono  
(Conver Placeholder) 

 

Modelado automático de tuberías 
 
Para crear un sistema de tuberías se debe incluir todos los elementos que serán conectados 
a través de tramos de tuberías. Se debe tener en cuenta: 



 

• Conectores: los elementos que van a formar parte del sistema deben tener 
conectores con la misma clasificación. 

• Diseño: el diseño generado de forma automática debe contar con un criterio y debe 
ser avalado por un especialista. 

• Categoría de elementos: Los elementos que se van a conectar automáticamente 
a través de la función Generate Layout deben pertenecer a la categoría Mechanical 
Equipment o Plumbing fixtures. 

 
Para crear un sistema de tuberías: 
 

1. Colocar en el proyecto los elementos que serán parte del sistema. 
2. Seleccionar uno o varios objetos que serán parte del sistema. 

 

 
 

3. En la pestaña Modify => panel Create Systems => icono  Piping 
4. Seleccionar la clasificación del sistema en la casilla System type, e ingresar el 

nombre del nuevo sistema. 
 

 
 
Nota: al activar la opción “Open in System Editor” y luego presionar el botón OK, el editor 
de Sistemas se abre automáticamente. 
 
Para editar un sistema: 
 

1. Seleccionar cualquiera de los elementos que pertenece al sistema 
 



 

2. En la pestaña Piping System => escoger icono  Edit System 
 

3. En el editor de sistemas, presionar el botón  Add to System para agregar 
otros elementos al sistema. 
 

4. Con el icono  Remove From System se puede remover un elemento del 
sistema.  

5. El botón  Select Equipment permite añadir un equipo de suministro como 
un tinaco o algún otro equipamiento. 
 

6. Presionar el botón   Finish Editing System, para finalizar la edición del 
sistema. 

 

Ruteo automático de tuberías 
 
Los elementos de un sistema se pueden conectar automáticamente con tuberías a través 
de la función Generate Layout.  
 

1. Seleccionar cualquiera de los elementos que forman parte del sistema. 

2. Escoger pestaña Modify => panel Layout => icono  Generate Layout. 
 

3. en la barra de opciones, puede escoger cualquiera de las soluciones sugeridas por 
Revit. (Network, Perimeter, Intersections).  

 



 
 
Los controles que se despliegan del lado derecho de la casilla Solution Type, permiten 
navegar a través de las opciones de soluciones que proporciona Revit. Cada Tipo de 
solución puede contener una o varias propuestas. Las soluciones serán visibles en la 
pantalla mostrándose con líneas de color azul (tuberías principales y verde (tuberías 
secundarias). 
 

 
 

4. Con el botón Settings es posible revisar la configuración de Conversion para el 
tipo de tubería que se usara para el ramal principal y secundario, además la altura 
(offset) de los ductos con respecto al nivel. 

 

 
 

12. Presionar el botón OK, para salir del cuadro de dialogo Pipe conversión Settings. 
 

Para revisar opciones de ruteo: 
 
Después de revisar las configuraciones se debe observar que las líneas que representan 
las tuberías se muestren en color azul (tramos principales), y verdes (tramos secundarios). 
En caso de que se observen segmentos de línea en color naranja indica que existe un 



conflicto y Revit no puede resolver estas conexiones, lo cual puede deberse a varios 
motivos: 
 

• Las diferencias de altura entre las tuberías principales y secundarios son muy 
estrechas, y los accesorios no pueden ser conectados correctamente. 

• Algunos elementos del sistema están muy cerca, por lo tanto, los accesorios no 
pueden ser conectados correctamente. 

• El ancho de las tuberías no permite una transición correcta para conectarse. 

• Los elementos para conectar están desalineados o en ángulos que el sistema 
no puede resolver. Etc. 

 
Para modificar el diseño de las opciones de ruteo: 
 

1. Seleccionar una de las soluciones de ruteo. 
 

 
 

2. En la pestaña contextual Generate Layout => Escoger icono    Edit Layout  
3. Seleccionar el tramo o tramos de tubería a desplazar. 

Revit creará una solución llamada Custom 
 

4. Clic en el icono   (Finish Layout) para crear las tuberías. 
 
 



 
 

Creación de sistemas de protección contra incendios  
 
Para generar un sistema de PCI de forma automática, considere las siguientes 
características. 
 

• Conectores: los conectores deben de contar con la misma clasificación para los 
sistemas PCI. 

• Ruteo de componentes: las tuberías deben de contar con preferencias de ruteo, así 
como ser asignado al sistema de clasificación en las propiedades mecánicas.  

• Diseño: El diseño generado de forma automática debe contar con un criterio y debe 
ser avalado por un especialista.  

 
Pasos crear un sistema de tuberías PCI: 
 

1. Colocar en el proyecto los aspersores y equipos mecánicos a conectar. 
2. Seleccionar uno o varios objetos, por ejemplo, bomba hidroneumática. 

3. En la pestaña Modify seleccione el botón Piping 
4. Seleccionar el tipo de sistema e ingresar el nombre del nuevo sistema 

 

 



5. Presionar el botón OK. 
 
Para editar un sistema: 
 

1. Seleccionar cualquiera de los elementos que pertenece al sistema 
 

 

2. En la pestaña Piping System => escoger icono  Edit System 
 

3. En el editor de sistemas, presionar el botón  Add to System para agregar 
otros elementos al sistema. 
 

4. Con el icono  Remove From System se puede remover un elemento del 
sistema.  

5. El botón  Select Equipment permite añadir un equipo de suministro como 
un tinaco o algún otro equipamiento. 
 

6. Presionar el botón   Finish Editing System, para finalizar la edición del 
sistema. 

 

Ruteo automático de tuberías 
 
Los elementos de un sistema se pueden conectar automáticamente con tuberías a través 
de la función Generate Layout.  
 

1. Seleccionar cualquiera de los elementos que forman parte del sistema. 



2. Escoger pestaña Modify => panel Layout => icono  Generate Layout. 
 

3. en la barra de opciones, puede escoger cualquiera de las soluciones sugeridas por 
Revit. (Network, Perimeter, Intersections).  

 

 
 
Los controles que se despliegan del lado derecho de la casilla Solution Type, permiten 
navegar a través de las opciones de soluciones que proporciona Revit. Cada Tipo de 
solución puede contener una o varias propuestas. Las soluciones serán visibles en la 
pantalla mostrándose con líneas de color azul (tuberías principales y verde (tuberías 
secundarias). 
 

4. Con el botón Settings es posible revisar la configuración de Conversion para el 
tipo de tubería que se usara para el ramal principal y secundario, además la altura 
(offset) de los ductos con respecto al nivel. 

 

 
 
Presionar el botón OK, para salir del cuadro de dialogo Pipe conversión Settings. 
 
Para revisar opciones de ruteo: 
 
Después de revisar las configuraciones se debe observar que las líneas que representan 
las tuberías se muestren en color azul (tramos principales), y verdes (tramos secundarios). 
En caso de que se observen segmentos de línea en color naranja indica que existe un 
conflicto y Revit no puede resolver estas conexiones, lo cual puede deberse a varios 
motivos: 
 



• Las diferencias de altura entre las tuberías principales y secundarios son muy 
estrechas, y los accesorios no pueden ser conectados correctamente. 

• Algunos elementos del sistema están muy cerca, por lo tanto, los accesorios no 
pueden ser conectados correctamente. 

• El ancho de las tuberías no permite una transición correcta para conectarse. 

• Los elementos a conectar están desalineados o en ángulos que el sistema no 
puede resolver. Etc. 

 
Para modificar el diseño de las opciones de ruteo: 
 

5. Seleccionar una de las soluciones de ruteo. 
 

 
 

6. En la pestaña contextual Generate Layout => Escoger icono    Edit Layout  
7. Seleccionar el tramo o tramos de tubería a desplazar. 

 

 
Revit creará una solución llamada Custom 

 

8. Clic en el icono   (Finish Layout) para crear las tuberías. 
 



 
 
 

Tubería flexible  
 
Para modelar tuberías flexibles siga estos pasos 
 
1. Identifique el conector de la familia de donde desea realizar la tubería flexible  
2. De clic derecho sobre el conector, en el menú desplegable seleccione Flex pipe 

 
3. Seleccione el conector de la otra familia para conectar la tubería flexible  
4. Corrobore la creación de la tubería  

 
 
  



Capítulo 5  
 

Sistemas eléctricos 
 
El panel Electrical proporciona los comandos para añadir componentes eléctricos para crear 
los circuitos eléctricos de un proyecto, además de charolas y conduits. 
 

Colocación de familias eléctricas  
 
Los elementos que van a formar parte de los circuitos eléctricos se encuentran clasificados 
en diferentes categorías; Equipos eléctricos, Dispositivos y Luminarias. Estos elementos se 
encuentran definidos en familias cargables. 
 

 
 
Para cargar familias de elementos eléctricos: 
 

1. Abrir un proyecto y activar la vista donde se van a colocar los elementos. 
2. Seleccione la pestaña Insert => Panel load From family => Load Family. 
3. Si está usando la librería US Metric, buscar la carpeta Electrical/Mep 

 



 
 

4. Escoger pestaña Systems => panel Electrical 
5. Según la categoría en la que se encuentre el elemento a insertar se debe escoger 

el comando Electrical Equipment, Electrical Divices, Lighting fixture. 
 

 
 

6. En el selector de tipos, escoger familia y tipo a utilizar. 

 
 

7. Colocar la familia sobre en el área de dibujo. 
 



  
 
 

Propiedades básicas de familias Eléctricas y PCI 
 
Es necesario identificar los tipos de conectores que pueden estar definidos en una familia 
de equipos o elementos eléctricos, los cuales son: Eléctricos, charolas y tubo Conduit. 
 
Para editar un conector: 
 

1. Seleccionar el conector. 
2. En la paleta de propiedades, realizar los cambios según el tipo de conector 

escogido. 
 

• Conector Eléctrico  : Contiene todos los parámetros necesarios para 
vincular la familia a un circuito eléctrico, para luego realizar análisis de cargas. 
 

    
 

Las propiedades que tiene un conector eléctrico se describen en la siguiente tabla: 
 



 
 

• Conector de charolas : permite configurar un conector de 
charolas. 
 

 
 

• Conectores de Tubos Conduit : permite configurar un 
conector de tubo Conduit. 
 

 
 

Propiedades de conector de tubo Conduit  
 
Las propiedades que tiene el conector de Conduit son los siguientes: 
  
Conector Conduit individual: 



• Angle: Especifica el Angulo del conector 

• Diameter: Permite colocar el diámetro a la tubería Conduit 

• Connector Description: Permite colocar una descripción del conector 
 

 
Conector Conduit superficial: 
 

• Angle: especifica el ángulo del conector 

• Connector Description: permite colocar una descripción del conector 
 

 
 

Crear y editar circuitos eléctricos (Para representación)  
 
Los circuitos conectan componentes eléctricos similares para formar un sistema eléctrico, 
estos circuitos son: Eléctricos y Otros. 
 

Sistemas eléctricos 
 
Cuando se crean circuitos para un sistema eléctrico, solo se pueden conectar dispositivos 
compatibles. Todos los dispositivos de un circuito deben especificar el mismo sistema de 
distribución (voltaje y número de polos). Los sistemas eléctricos pueden ser; sistemas de 
iluminación y de distribución de la potencia.  

 

Otros sistemas  
 
Son los sistemas de datos cómo:  teléfono, alarma contra incendios, comunicaciones, 
timbre de enfermería, seguridad y de control. Aunque solamente se pueden conectar 
componentes similares en un sistema determinado, no se realizan comprobaciones de 
compatibilidad relacionadas con el voltaje o número de polos entre los componentes que 
conforman los sistemas. Corresponde al diseñador del sistema mantener la coherencia de 
los dispositivos conectados en estos sistemas.  
 

Colocación de elementos eléctricos  
 
Para colocar familias eléctricas para circuitos de potencia: 
 

1. Cargar y colocar en la vista los elementos del equipamiento eléctrico con o sin 
hospedaje. 



2. Cargar y colocar en la vista los elementos de dispositivos eléctricos para generar el 
circuito 

 

 
 
Para colocar familias eléctricas para circuitos de iluminación: 

3. Cargar y colocar en la vista las luminarias, usando el comando  Lighting 
Fixture. 

4. Cargar y colocar en la vista los elementos de dispositivos eléctricos usando el 

comando  (Lighting). 

  
 

creación de circuitos eléctricos 
 
Para crear un circuito de potencia: 
 

5. Seleccionar el elemento que corresponde a un equipo eléctrico. En la barra de 
herramientas de opciones en la casilla Distribution System, asignar un sistema de 
distribución. 

 



 
 
Importante: para que un sistema de distribución pueda ser asignado a un equipo, este 
debe haber sido previamente creado y configurado en la caja de dialogo Configuraciones 
eléctricas. 
 

6. Seleccionar uno o varios de los elementos eléctricos que serán parte del circuito 
eléctrico. 

 

 

7. Escoger pestaña Modify => panel Create Systems =>> icono   Power  
8. Se crea el sistema, y los elementos que son parte del circuito se resaltan en la vista. 

 

 
 



9. En la pestaña Modify escoger icono  (Select Panel)  
10. Seleccionar el tablero que se vinculará al circuito. 

 

 
 
Importante: todos los circuitos de potencia deben tener asignado un tablero, este se puede 
asignar mientras se crea el sistema, o se puede editar el circuito para agregarlo 
posteriormente. 
 

Edición de elementos de un circuito eléctrico 
 
Para editar un circuito: 
 

1. Seleccionar un elemento que pertenezca a un circuito. 
2. Escoger pestaña Electrical Circuits. 

 

 
 

3. Escoger icono  Edit Circuit para entrar a la edición del circuito. 

4. En el editor de sistemas, presionar el botón  Add to Circuit para agregar 
otros elementos al circuito. 

 

5. Con el icono  Remove From Circuit se puede remover un elemento 
del circuito.  

6. Desplegar la casilla Panel para vincular un tablero al circuito. 



 

 
 

7. Presionar el botón   Finish Editing Circuit, para finalizar la edición del 
sistema. 

 
Para crear un circuito de iluminación: 
 

1. Seleccionar una o varias luminarias que tengan un conector eléctrico. 
 

 

2. Escoger pestaña Modify => panel Create Systems =>> icono   Switch.  
3. Se crea el sistema, y los elementos que son parte del circuito se resaltan en la vista. 

 



 
 

4. En la pestaña Modify => escoger icono  (Select Switch) 
5. Seleccionar en la vista el Switch 

 

 
 
 

Edición de elementos de un circuito de iluminación 
 
Para editar un circuito: 
 

6. Seleccionar un elemento que pertenezca a un circuito. 
7. Escoger pestaña Switch systems. 

 

 
 



8. Escoger icono  Edit Switch Systems para entrar a la edición del circuito. 
 

9. En el editor de sistemas, presionar el botón  Add to System para agregar 
otros elementos al circuito. 
 

10. Con el icono  Remove From System se puede remover un elemento del 
circuito.  

11. Con el icono  (Select Switch) se puede vincular un Switch al circuito, en la 
barra de herramientas de opciones desplegando la casilla Switch ID. 

 

 
 

12. Presionar el botón   Finish Editing System, para finalizar la edición del 
sistema. 

 

Generación de cableado eléctrico 
 
Al añadir tramos de cable entre dispositivos, no se crea un circuito. El tipo de cable debe 
ser definido en las configuraciones de la caja de dialogo Configuraciones eléctricas.  
 
Para crear segmentos de cable de forma manual: 
 

1. Activar una vista de planta o techo (ceiling).  
2. Visualizar los elementos del circuito a conectar. 
3. Seleccione la pestaña Systems => panel Electrical => desplegar icono Wire 
4. Escoger la forma de cable requerida para la representación. 

 



  
 

5. En la paleta de propiedades, en el selector de tipos, seleccionar el tipo de cable. 
6. Marque el primer punto desde el conector del accesorio eléctrico.  

 

 
7. En caso de haber escogido la opción de cable Arc o Spline, debe especificar un 

segundo punto en un punto cercano a los objetos a conectar a través del cable. 
 
 

 
 

8. Marque el tercer punto al conector del accesorio eléctrico.  
 

 
 

 
9. Realizar el mismo procedimiento para conectar los elementos a través del cable.  

 



 
 

Creación de cableado eléctrico automático  
 
Al añadir tramos de cable entre dispositivos, no se crea un circuito o se especifica el tamaño 
de los tramos de cables. 
 
Para crear cableado automáticamente: 
 

1. Acercar el puntero a un objeto que forme parte del circuito. 
2. Presionar la tecla TAB para realizar una previsualización el circuito. 

 

 
 

3. Seleccionar en el área de dibujo o en la pestaña Modify la forma de cable a utilizar. 
4. En la paleta de propiedades, desplegar el selector de tipos y escoger el tipo de cable. 

 



 
 

5. Se genera la representación del cableado. Al ser una representación el cableado 
solo se puede crear y visualizar en vistas de planta. 

 

Modelado de tubería Conduit y charola 
 

Modelado de tubería Conduit 
 
Para dibujar un Conduit horizontal: 

1. Seleccione la pestaña Systems => Panel Electrical => Comando Conduit  
2. En la paleta de propiedades, en el selector de tipos escoger el tipo de Conduit. 
3. En la casilla Diameter escoger el diámetro.  
4. En la casilla Offset escribir la altura con respecto al nivel donde se dibuja el Conduit. 

 
 

5. Definir un primer punto para marcar el inicio del conduit, después marcar un segundo 
punto para terminar el primer tramo. 

6. Dar un tercer clic para dar continuación a la tubería en la misma o diferente dirección 
7. Clic en el botón Modify para terminar la creación de tubería Conduit. 



 
 
 

Modelado de tubería Conduit vertical 
 
 

1. Crear una vista de corte y activarla. 
 

 
 

2. Seleccionar la tubería Conduit, dar clic sobre el conector Conduit, en el submenú 
escoger opción Draw Conduit. 

3. Trazar el conduit en sentido vertical hasta el punto deseado. Al cambiar la dirección 
del tramo de Conduit, automáticamente genera un codo.  

 
4. Clic en el botón Modify para terminar la creación de tubería Conduit. 



 
 

Modelado de charola  
 
Para dibujar un tramo de charola:  
 

1. Escoger pestaña System => panel Electrical => Cable Tray 
2. En la barra de opciones, escoger las opciones para el tamaño ancho (Width) y alto 

(Height) 
3. En la casilla Offset escribir el valor de altura con respecto al nivel. 

 

 
 

4. En la paleta de propiedades, en el selector de tipos, seleccionar el tipo de charola. 
 

 
 

5. Definir un primer punto, luego un segundo punto para terminar la trayectoria. 
 



 
 

6. Para modificar la trayectoria cambiar de dirección. 
 

 
7. Clic al botón Modify para terminar el comando. 

 

 

Modelado de charola vertical 
 
Modelado de charola (modo 1): 
 

1. Seleccionar un tramo de charola creada => dar clic al conector => en el submenú 
escoger Draw cable tray. 

 



 
 

2. En la paleta de propiedades, en el selector de tipos escoger un tipo de charola. 
 

 
 

3. En la barra de herramientas de opciones, en la casilla Offset escribir el valor de 
altura de la charola => clic en el botón Apply para efectuar los cambios. 

 

 
 

4. Clic en el botón Modify para terminar el comando. 
 

Modelado de charola (modo 2) 
 

1. Activar una vista de corte. 
2. Seleccionar el conector de charola y hacer clic derecho => en el submenú escoger 

la opción Draw Cable tray. 
3. Tace la trayectoria de la charola. 
4. Click en botón Modify para terminar el comando. 

 



 
Nota: La charola permite conectar los tubos Conduit, para esto deben de contar los tubos 
Conduit la altura (offset) que cuenta la charola. Cuando una tubería Conduit se conecta a 
la charola, el programa genera una línea representativa la cual indica que se ha establecido 
la conexión.  

 
 
 
  



Capítulo 6 
 

Comprobación de sistemas (Check systems)  
 
Permite examinar los sistemas mecánicos (ducto y tuberías) para comprobar que cada uno 
de ellos esté asignado a un sistema definido por el usuario y conectado correctamente. Se 
puede mostrar marcas que indican los conectores que no estén desconectados. Se recomienda 
tener activas las marcas cuando se realiza la comprobación de los sistemas. 
 
Para mostrar marcas de desconexión: 
 

1. Escoger pestaña Analyse => panel Check systems => icono   (Show 
Disconnects) 

2. En la caja de dialogo escoger los tipos de sistemas que mostrarán marcas 

 

 
 

3. Presionar el botón OK. 

 

Comprobación de sistemas mecánicos 
 
Para revisar un sistema: 
 

1. Escoger pestaña Analyse => panel Check systems => icono  (Check Duct 

systems) o  (Check pipe systems) 
2. Se despliegan diferentes marcas que indican las inconsistencias en el sistema. 

 



 
 

1. Al hacer click sobre una marca se observa la información de los elementos 
desconectados. 

 

 
 

  

Comprobación de circuitos 
 
Permite buscar componentes que no estén asignados a un circuito y examinar los circuitos de 
los planos para comprobar si cada uno de los circuitos está correctamente conectado a un panel. 
 

Para revisar un sistema: 
 

1. Escoger pestaña Analyse => panel Check systems => icono  (Check Circuits)  
2. Se muestra en una ventana con los datos de inconsistencia en el sistema. 

 



 
 

System Browser 
 

Permite buscar componentes que no estén asignados a un sistema. Se muestra como una 
ventana independiente en la que se observa la lista jerárquica de todos los componentes 
de cada disciplina del proyecto organizados por sistemas, zonas o sistemas analíticos.  
 
Para abrir la ventana System Browser: 

1. Escoger pestaña View => panel Windows => desplegar icono  (User 
interface) => opción System Browser 

 

 
 

2. Para revisar los componentes de un sistema, desplazarse a través del listado y 
seleccionar el sistema por el nombre. 



3. Los elementos que son parte del sistema se resaltan automáticamente. 
 

 
 
 
 
 
 

 


